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General informationGeneral informationGeneral informationGeneral information    
The following description covers all the functions available in Term Web Professional V3.  
The functions, and also the dictionaries and dictionary sections, to which you have access, are 
associated with your user group and authorization. Also, certain functions described in this 
document may or may not be enabled by the administrator of your installation. 

Log inLog inLog inLog in    

 
Enter your company name (ClientClientClientClient) if it has not been automatically entered, your User name User name User name User name and 
PasswordPasswordPasswordPassword issued by the administrator and then click Log inLog inLog inLog in. (In applicable cases, please select 
user interface language.) 
 
If you are already logged in but want to log in using a different authorization, log off (click Log Log Log Log 
out out out out in the top right-hand side of the window), enter the new User nameUser nameUser nameUser name and PasswordPasswordPasswordPassword issued by 
the administrator and click Log inLog inLog inLog in. 

OverviewOverviewOverviewOverview    

 

 

Result pane 
Term list 

Target language 

Section and additional 
dictionary selector 

Domain 
selector 

Search 
field 

Advanced Search 
button 

Primary dictionary 
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Toolbar 
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language 
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Set the source language, target language and how much you want to view in the Set the source language, target language and how much you want to view in the Set the source language, target language and how much you want to view in the Set the source language, target language and how much you want to view in the 
result paneresult paneresult paneresult pane    
If you want to find a term in a language other than the current source language, then select the 
desired source language from the droplist in the SourceSourceSourceSource field. 
 
You can also limit the results shown to one target language. 
Click the box beside TargetTargetTargetTarget above the result pane and choose the desired target language. 
If you would like all languages to be displayed, choose All languagesAll languagesAll languagesAll languages in the Target Target Target Target box.  
To specify how much term information is shown for each language in the dictionary: 
Click on Custom viewCustom viewCustom viewCustom view and choose which languages should be shown along with the level of 
detail you want for each language (e.g. the term only or all term information).  
Then choose Custom Custom Custom Custom from the TargetTargetTargetTarget droplist. 
 
If you would like to display the term’s history (information about when and by whom the term 
record was created and changed), click SettingsSettingsSettingsSettings and check the Show history Show history Show history Show history box. Deselect the 
Show historyShow historyShow historyShow history check box when you want to hide the information. 
 
Note!Note!Note!Note!    
The administrator can also specify which fields are displayed for each user, e.g. which level of 
information is shown. A single term record can be displayed differently depending on which user 
is logged in. 

Search for a termSearch for a termSearch for a termSearch for a term    
You may want to choose the dictionary first. See What is a dictionary?. 
If you want to limit the search to certain sections in the dictionary, begin by choosing the 
desired sections. See the section What is a section?. 
Select the language of the term you want to find.  
If you want to search for a term in Spanish, for example, then select SpanishSpanishSpanishSpanish from the SourceSourceSourceSource 
droplist. 
Then type the search string in the Search Search Search Search field. 
If you want to limit the search to a certain domain or subdomain, click Domain searchDomain searchDomain searchDomain search under the 
search field and select the domain(s). See also the section entitled Show a particular domain or 
subdomain. 
 
Example 1:Example 1:Example 1:Example 1: Type dog* and click SearchSearchSearchSearch. A list of all the terms beginning with “dog” will be 
shown. 
Example 2:Example 2:Example 2:Example 2: Type *dog* and click SearchSearchSearchSearch. A list of all the terms that contain the text string “dog", 
e.g. 'dog', 'army dog training centre' and 'watchdog' will be shown. 
Example 3:Example 3:Example 3:Example 3: Type dog and click SearchSearchSearchSearch. A list including the term “dog" and adjacent terms will be 
shown. 
Click the term you want to see. 
If more than two languages are displayed and you want to see all the information in a particular 
language for a given term, click the term in the desired language. The term and all of its 
detailed information will be shown in the result pane. 
(See also information for customizing the display under “Set the source language, target 
language and how much you want to view in the result pane” above.) 
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Advanced searchAdvanced searchAdvanced searchAdvanced search    
If you are not sure of the spelling or wish to search the term in fields other than the term field 
then you can use the Advanced search options. When doing an advanced search, do not use 
asterisks (unless the text you are looking for includes asterisks). 

Fuzzy searches Fuzzy searches Fuzzy searches Fuzzy searches ---- searching for approximate strings searching for approximate strings searching for approximate strings searching for approximate strings    

If you are unsure of the exact spelling of the term: 

1. Click on the advanced search button ( ). 
2. Check the box Enable fuzzy search Enable fuzzy search Enable fuzzy search Enable fuzzy search and then click ApplyApplyApplyApply.  

 

3. The button for advanced searches changes color: . 
4. Write the term “plattform" or a part of the term (without asterisks) in the search field, with 

Italian as the source language. The terms that approximately match the search string will be 
shown, e.g. piattaforma.  

Search in multiple fieldsSearch in multiple fieldsSearch in multiple fieldsSearch in multiple fields    

If you want to search for a particular string that might be found not only in a term but even in a 
definition or comment: 

1. Click on the advanced search button ( ). 
2. Check the box Enable multiEnable multiEnable multiEnable multi----field search. field search. field search. field search. Check then the Selected fieldsSelected fieldsSelected fieldsSelected fields box and choose the 

fields that you want to search. Click ApplyApplyApplyApply.  
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3. Type the search string (without asterisks) in the search field. All the term records are then 

shown where some part of the chosen fields (on the concept level as well as the source 
language) includes the search string. Note that the advanced search arrow changes color 

 when the multi-field search option is activated. 

UseUseUseUse filters to search and export filters to search and export filters to search and export filters to search and export    
If you want to search for term records or term equivalents that fulfill specific criteria, e.g. all 
term records that do not have a definition, all term records that do not have a term equivalent 
in a certain language or term equivalents with a certain status, you can use the filter function. 
Note! Note! Note! Note! A filter limits the search to the selected dictionary. A filter can be defined to be private 
(only accessible for the creator) by setting its visibility to OwnerOwnerOwnerOwner or accessible for a certain 
group selected in the VisibilityVisibilityVisibilityVisibility droplist, or to all users, if Default groupDefault groupDefault groupDefault group is selected in the 
Visibility droplist. However, only the owner of the filter, or an administrator, can edit or delete a 
filter.  
If an administrator is unable to delete a filter, it is because it is in use (in an export setting or as 
a standard filter for a group). 
 
You can use several combinations of conditions in the filter. 
You can create a set of filters for a certain dictionary and then select them from the FilterFilterFilterFilter 
droplist or by clicking the Filters icon and then > Apply filterApply filterApply filterApply filter. Note that the term list gets a 
yellow background to signal that a filter is applied. Filters can also be applied to term export by 
clicking on the AdminAdminAdminAdmin icon and then on the ExportExportExportExport icon. The filter is then chosen under Export Export Export Export 
settingssettingssettingssettings in the Select concepts by filterSelect concepts by filterSelect concepts by filterSelect concepts by filter field. 
The conditions for the field contents can be set as follows: 
a) fields that contain an exact string (typed after “EQUALS” or, if you do not enter a search 
string, empty fields) 
b) fields that contain the string and additional contents (typed after “CONTAINS”) 
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c) fields that do not contain the string (typed after “NOT CONTAINS”) 
d) fields that are not equivalent to a specific string (typed after “NOT EQUALS” or, if you do not 
enter a search string, fields that contain something; i.e. “not equal to nothing") 
e) fields that start with a certain string (typed after STARTS WITH) 
f) for certain fields: that fulfill a specific time value, e.g. that were changed before (BEFORE) or 
after (AFTER) a specific point in time (date and time) or on a specific date (EQUALS), or outside 
of a specific date (NOT EQUALS) 
g) for numeric fields: where the field value EQUALS, NOT EQUALS, is LESS THAN or GREATER 
THAN a typed-in integer value 
 

Temporary and saved filtersTemporary and saved filtersTemporary and saved filtersTemporary and saved filters    

You can create a temporary filter. (If you want to reuse it you can save it later.) 
 
To create a temporary filter: 

1. Click  beside the Search button. 
2. Click Create temporary filterCreate temporary filterCreate temporary filterCreate temporary filter. 
3. Enter filter criteria in the dialog box. 

For example: 

 
4. Click ApplyApplyApplyApply. 

Only the term records that fulfill the criteria you have entered are shown.  
In the example, only those term records are shown that have at least one term (in any 
language) that contains the string "frequenc". 
The temporary filter is applied to the current main dictionary until you create a new 
temporary filter for any dictionary. 

 

 
5. If you want to deactivate the filter, select <No filter> in the Filter Filter Filter Filter droplist box in the upper 

left-hand column:::: 

 

6. If you want to edit or save the filter, click the filters icon  again. 
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If you want to create and save a filter or edit an existing filter, use the  button and click Add Add Add Add 
new filternew filternew filternew filter or click EditEditEditEdit to the right of the filter name. See the example below. 

Example:Example:Example:Example:    

You can filter term records on the basis of the concept level fields that apply to the term record 
or to the fields that belong to the terms of a certain language (under Term level).  
Note!Note!Note!Note! Use only search strings in the field, notnotnotnot wildcard characters. 
All filters are private, i.e. connected to a specific user name. Filters that have been created by 
the administrator can, however, be applied by other users if selected to be visible for, as an 
example All users or Guests. 
Note: All the examples below are taken from the TechniTerm glossary.Note: All the examples below are taken from the TechniTerm glossary.Note: All the examples below are taken from the TechniTerm glossary.Note: All the examples below are taken from the TechniTerm glossary.    
ExampleExampleExampleExample: To find all the term records with definitions containing the text string phase shift:  

1. Click the Filters Filters Filters Filters icon . 
2. Click Add new filter>>Add new filter>>Add new filter>>Add new filter>>. 
3. Name the filter. Note! A filter name may not be more than 25 characters. 
4. Indicate whether the filter should be available to yourself only or to all users within a 

specific user group in the VisibilityVisibilityVisibilityVisibility field. (Please note: Administrators can see and use all 
filters.) 

5. Replace the text <Select field> with the name of the field, for example Definition.Definition.Definition.Definition. Select 
CONTAINSCONTAINSCONTAINSCONTAINS in the box beside it and fill in the search string, e.g. phase shift.  
Click SaveSaveSaveSave and then Apply Apply Apply Apply by the filter’s name if you want to use the new filter immediately.  
(If the filter is already selected (applied) when editing in the future, simply click CloseCloseCloseClose.) 
All the term records with definitions containing phase shift will be shown. 

6. Click the term you want to see. 
 
Example 2Example 2Example 2Example 2: To find all the term records with phase shift in their definition and key in any of the 
English terms:  

1. Click the Filters Filters Filters Filters icon . 
2. Click Add new filter>>Add new filter>>Add new filter>>Add new filter>>. 
3. Name the filter and indicate its visibility. 
4. Select a field from the Filter criteria droplist <Select field> such as DefinitionDefinitionDefinitionDefinition (make sure 

that CONTAINSCONTAINSCONTAINSCONTAINS is selected in the box to the right of Definition), and fill in a search string in 
the box that appears to the right of CONTAINS, e.g. phase shift.  
Select ANDANDANDAND in the droplist below Definition (instead of <No operator>).  
Choose TTTTermermermerm and EXISTSEXISTSEXISTSEXISTS on the next line.  
On the line, under Term Criteria, choose TermTermTermTerm and CONTAINSCONTAINSCONTAINSCONTAINS and write key in the field to 
the right of CONTAINS. 
Choose ANDANDANDAND in the droplist (instead of <No operator>).  
Choose Language, EQUALSLanguage, EQUALSLanguage, EQUALSLanguage, EQUALS and EnglishEnglishEnglishEnglish on the next line.  
Click SaveSaveSaveSave and then Apply Apply Apply Apply by the filter’s name if you want to use the new filter immediately.  

5. Click the term you want to see. 
 
Note! 1Note! 1Note! 1Note! 1: If you want to deactivate the filter, select <No filter> in the Filter Filter Filter Filter droplist in the left-

hand column.... 
Note! 2Note! 2Note! 2Note! 2: If you want to use a previously defined filter, then select the filter shown in this Filter Filter Filter Filter 

droplist: 
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Example 3Example 3Example 3Example 3: Find all the term records that have a definition and a term with Usage USA: 

1. Click the Filters Filters Filters Filters icon .. 
2. Click Add new filter>>Add new filter>>Add new filter>>Add new filter>>. 
3. Name the filter and indicate its visibility. 
4. Replace the text <Select field> in the droplist with DefinitionDefinitionDefinitionDefinition.  

Make sure that NOT EQUALSNOT EQUALSNOT EQUALSNOT EQUALS appears in the box to the right.  
Do not fill in anything in the box that appeared to the right of the NOT EQUALS field.  
Then choose ANDANDANDAND from the droplist (instead of <No operator>).  
Choose TermTermTermTerm and EXISTSEXISTSEXISTSEXISTS on the next line.  
On the line under Term Criteria, choose UsageUsageUsageUsage and EQUALSEQUALSEQUALSEQUALS and select USAUSAUSAUSA from the droplist 
to the right of EQUALS.  
Click SaveSaveSaveSave and then Apply Apply Apply Apply by the filter’s name if you want to use the new filter immediately.  

5. Click the term you want to see. 
    

Creating a permalink Creating a permalink Creating a permalink Creating a permalink to refer to to refer to to refer to to refer to a a a a term record term record term record term record     
To create a link to a specific term record: 
1. Click the desired term in the term list. 

2. Click the green Permalink button  in the upper right part of the result window. 
3. Copy the link information from the web browser address field. 
4. Paste and use this link in other documents, to refer to the specific term. 
5. Users who are not authorized to see the term entry (e.g. guest users), will get a TermWeb 

view with no concept in focus (empty result window). 
    

Enter a new term record Enter a new term record Enter a new term record Enter a new term record     
1. Check first to make sure that the term, with the same or a similar definition, does not 

already exist in a dictionary. 
See Search for a term above. 
Please note that while editing you can “restore” and return to the previous page by pressing 
Alt+XAlt+XAlt+XAlt+X    (in Internet Explorer), by clicking Cancel at the bottom of the windowpane, or by 

clicking on the red x icon  in the upper right-hand corner of the windowpane. 

2. Click the NewNewNewNew icon .  
3. Press Alt+OAlt+OAlt+OAlt+O (in Internet Explorer) or click Edit concept level fields...Edit concept level fields...Edit concept level fields...Edit concept level fields.... Enter the information 

you have for the concept level fields, e.g. enter the term’s definition and specify the domain 
and subdomain. For more information about domains, see the section Show a particular 
domain or subdomain.) 
In order to show as much of the domain selection frame as possible, you can switch to full 
screen view (F11 in Internet Explorer). Specify the term record subdomain(s) by clicking 
Select domainsSelect domainsSelect domainsSelect domains and then the plus sign beside the desired domain and subdomain. 
Here you can also choose the section in which the term record will be placed. 
Then press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click on Save.Save.Save.Save. 

4. Press Alt+AAlt+AAlt+AAlt+A (in Internet Explorer) or click on Add term...Add term...Add term...Add term..., choose the language and fill in the 
term along with the information for the chosen language. Then press Alt+SAlt+SAlt+SAlt+S (in Internet 

Explorer) or click on the green tick icon  in the upper right-hand corner or click on SaveSaveSaveSave 
at the bottom of the page. 
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Duplicity check: Duplicity check: Duplicity check: Duplicity check: When you click Save, in case there is already a homonym (homograph) 
term, i.e. a term with the same spelling, in the same language, in the present dictionary, you 
will get a question like the following:  

This gives you the possibility to skip creating a new concept with the term (in case the 
existing term is representing an identical or very similar concept) or click Yes and go on 
creating the concept with the identified duplicate term. 
 

5. If you want to enter a term in another language, click either  

Add termAdd termAdd termAdd term...   (Alt+AAlt+AAlt+AAlt+A in Internet Explorer) or Copy term... Copy term... Copy term... Copy term...  (Alt+CAlt+CAlt+CAlt+C    in Internet 
Explorer) is used to select the new language and enter the term as instructed in the previous 
step. 

6. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click SaveSaveSaveSave when you have finished updating the term 
record.  
If you want to create another term record, press Alt+NAlt+NAlt+NAlt+N (in Internet Explorer) or click 
SaveSaveSaveSave    &&&&    NewNewNewNew. 
If you want to create another term record based on the current entry, click SaveSaveSaveSave    &&&&    Duplicate Duplicate Duplicate Duplicate 
(Alt+DAlt+DAlt+DAlt+D in Internet Explorer) ). In the latter case, all information will be duplicated, including 
the information about the domain(s) and section. 
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Enter a new term record based on an existing term record Enter a new term record based on an existing term record Enter a new term record based on an existing term record Enter a new term record based on an existing term record     
1. Check first to make sure that the term, with the same or a similar definition, does not 

already exist in a dictionary.  
See Search for a term above. 

2. Click on a term from the term list that you would like to use as a template. 

3. Click on the CopyCopyCopyCopy icon . 
4. Continue from step 3 Change a term record below. 
 

Change a term record Change a term record Change a term record Change a term record     
You can easily change or modify a term record, including the information in the concept level 
fields and the information about term equivalents in each language. 
For example, if you want to change the information about a German term equivalent: 
1. Show the term record. Click on the term in the list in the left-hand column to make the 

contents of the term record visible in the result pane to the right. 

2. Click the Edit Edit Edit Edit icon . 
3. Click the German term (if German has not already been set as the source language). 
4. Click Edit term Edit term Edit term Edit term (Alt+EAlt+EAlt+EAlt+E in Internet Explorer).  
5. Change or add the desired information in the fields shown. 

If you want to copycopycopycopy a certain field valuefield valuefield valuefield value, e.g. “Source” or “Part of speech” to all terms (in all 
languages) in the concept, select or type a field value and click the  icon to the right of 
the field and confirm the operation. The field value will the be copied to the field in all 
terms in the concept, replacing any previous content of the field. 

6. Click the green tick mark at the upper right-hand side of the term field box or click SaveSaveSaveSave. 
7. If you want to change a term equivalent in another language: 

Click the term in that language. 
Click Edit term Edit term Edit term Edit term (Alt+EAlt+EAlt+EAlt+E in Internet Explorer).    
Change the information and then press Alt+S Alt+S Alt+S Alt+S (in Internet Explorer) or click on the green tick 
at the upper right-hand side of the window or click SaveSaveSaveSave. 

8. If you want to change the information in the concept level fields, press Alt+OAlt+OAlt+OAlt+O (in Internet 
Explorer) or click Edit concept level fields...Edit concept level fields...Edit concept level fields...Edit concept level fields..., change the information and then press Alt+SAlt+SAlt+SAlt+S (in 
Internet Explorer) or click SaveSaveSaveSave. 

9. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or SaveSaveSaveSave in the button field at the bottom of the window 
when you have finished updating the term record. 

Add a term to an existing term recordAdd a term to an existing term recordAdd a term to an existing term recordAdd a term to an existing term record    

You can add a new term equivalent in another language to an existing term record. 
If you wish to add a Portuguese term equivalent, for example, do the following: 
1. Show the term record. Click on the term from the list so the content of the term record will 

be visible in the result pane. 

2. Click the Edit Edit Edit Edit icon . 
3. Press Alt+AAlt+AAlt+AAlt+A (in Internet Explorer) or click on Add term...Add term...Add term...Add term.... 
4. Add the additional information about the Portuguese term. 

(Scroll down if necessary.) 
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Write the Portuguese term in the “Term" field and change “Language" if necessary, to 
Portuguese. 

5. Then press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click on the green tick in the upper right-hand 
corner or click on SaveSaveSaveSave. 

6. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or SaveSaveSaveSave in the button field at the bottom of the window 
when you have finished updating the term record. 

UUUUndo changes in a term recordndo changes in a term recordndo changes in a term recordndo changes in a term record    

If you want to undo changes that you have made in a term record, click SettingsSettingsSettingsSettings, select the 
Show historyShow historyShow historyShow history check box and then click on the restore arrow  under RestoreRestoreRestoreRestore beside the earlier 
version of the term record which you want to restore. 
The system administrator and administrators can also cancel other users’ changes by restoring 
previous records.  
Notes! 
It is not possible to undo a change made using the Restore Restore Restore Restore function described above.  
Furthermore, changes in concept relations and attached objects (including thumbnails) are not 
registered in the history and thus cannot be undone. 
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Add a cAdd a cAdd a cAdd a comment to omment to omment to omment to a a a a term recordterm recordterm recordterm record        

All users (but guest users) can comment on existing term records, for example suggest additions 
and modifications, provide usage examples etc. (See also the Send feedback function, that can 
be used to send system- or dictionary-related email comments to the respective administrator.)  
 
Do as follows:  

1. With the desired term record in the result window, click the  icon:  
2. Enter (type or paste in) your comment and click Save.Save.Save.Save. 
3. If you change your mind and do not want to save the comment, click the Cancel icon. 
4. If you want to remove your comment, click the dustbin icon above your comment. 

 
5. Please note that you may only remove your own comments, unless you are an administrator, 

who may remove the comments of all users: 
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Using multivalue fieldsUsing multivalue fieldsUsing multivalue fieldsUsing multivalue fields    

If you want to select more than one attribute for a certain concept, you can use a multivalue 
field. Enter data in the following way: 
1. Ctrl-click the values (e.g. concept attributes) that apply  
2. Click the blue right-arrow to move the values to the SelectedSelectedSelectedSelected list  
3. Click Save Save Save Save to save the information (and Save Save Save Save again to save the concept). 
 

 
For import and export files, the format is comma-separated, for the example above: 
Asia, Europe, North America 
e.g.  
<descrip id="c263-f3" type="Lives in">Asia, Europe, North America</descrip> 
in a TBX export file. 
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Add crossAdd crossAdd crossAdd cross----references, pictureferences, pictureferences, pictureferences, pictures and other objects to term recordsres and other objects to term recordsres and other objects to term recordsres and other objects to term records    
You can easily add a crosscrosscrosscross----referencereferencereferencereference from one of the fields in the term record (excluding the 
term name field or fields that may only have numeric contents) to either a specific term record 
or to a term in a specific language. 
Right click on the field that you want to add a cross-reference to and choose Add Internal LinkAdd Internal LinkAdd Internal LinkAdd Internal Link. 
For example, type See also shaft, highlight the word shaft, right click and choose Add Internal Add Internal Add Internal Add Internal 
LinkLinkLinkLink.  
A search box is then opened and you can search for desired terms or term records in any 
language.  
(Note! This applies to the sections in the dictionary that you have chosen to display!) 
Search for the entry with the English term shaft and click on the desired term. 
Then choose if you want to create a link to the term record (concept) with the word shaft or the 
actual word (term) itself ("Link is referring to" is linked to Concept or Term) and click SaveSaveSaveSave. In 
the case of the former (link to Concept), the term record is shown with the terms in the 
database’s order of languages. In the case of the latter (link to Term), the chosen term is shown 
first. 
Note!Note!Note!Note! When making changes, the link is shown in double angle brackets, e.g. «link word». If you 
later want to change the link, select the link word including the angle brackets, right click and 
choose Edit linkEdit linkEdit linkEdit link. 
Note! Links should normally not be created for terms that are not approved. (Term records or 
terms should be marked with a status “Approved" or “Correct" if the dictionary offers a status 
option.) 
 
If you want to add a link tolink tolink tolink to an explanatory PDF image PDF image PDF image PDF image (or a GIF  GIF  GIF  GIF or JPG image JPG image JPG image JPG image)    of a term record, 
then save the picture in a picture archive, right click on the link text as in the instructions 
above, choose Add External LinkAdd External LinkAdd External LinkAdd External Link and copy to or type a link in the URL URL URL URL field. Finish by clicking 
SaveSaveSaveSave. 
The link should be typed as a normal web link: 
http://www.my_terminology.com/graphics/figure.pdf.  
You can also add a link to a website in the same way:  
http://www.website.com 
 
If you place all objects to be linked (picture, sound, video clip files etc.) in the TermWeb File 
repository, you can then easily create a link to each object by double-clicking the object and 
then clicking Save.Save.Save.Save.    
    
To open the File repository, if not displayed: Click File Repository>>File Repository>>File Repository>>File Repository>>. 
To search for an object: Enter any text string contained in the object’s file name and click 
SearchSearchSearchSearch. 
 
To prepare for this; to add files to the file repository, select Admin ViewAdmin ViewAdmin ViewAdmin View > FileFileFileFile Repository Repository Repository Repository, click 
Add fileAdd fileAdd fileAdd file, browse to and select the desired file and, optionally, add a description of the file. Then 
click Create fileCreate fileCreate fileCreate file. 
To view (or play) the file, click View fileView fileView fileView file.  
It is also possible to upload files in batch to and download files in batch from the file repository: 
 



 
18 (62) 

© 2011 Interverbum Technology AB  Admin_and_User_Manual_TWPro_V3.8_R1B_EN.rtf 2011-04-14 

 
 

To upload files in batch to the file repository, click Import files from a zip fileImport files from a zip fileImport files from a zip fileImport files from a zip file, browse to and 
select the ZIP file containing the objects, and then click ImportImportImportImport. The ZIP file will be 
automatically uploaded and the objects unpacked into the file repository. 
To download files in batch from the file repository to a ZIP file, click Export all files in repository Export all files in repository Export all files in repository Export all files in repository 
to zip fileto zip fileto zip fileto zip file. You will then be able to save the ZIP file in a selectable directory in your computer or 
network. 
 
If you wish to attach a documentattach a documentattach a documentattach a document to the TermWeb concept (to display an image or another 
binary object, e.g. a PDF file), write any text that is to be shown before the object symbol (or 
illustration thumbnail), click Add AttachmentAdd AttachmentAdd AttachmentAdd Attachment, indicate the text that is to be shown when 
someone points to the object symbol in the field Display nameDisplay nameDisplay nameDisplay name and browse to the field or copy 
the link to the file that you want to read into the database to the File to attachFile to attachFile to attachFile to attach field.  
In this case the object is saved in the internal TermWeb database. 
Example of object symbols: ,  

 
To remove a file that has been attached according to the instructions above, do as follows: 
1. Edit the term record and right click on the image field in question. 
2. Choose Edit AttachmentsEdit AttachmentsEdit AttachmentsEdit Attachments. 
3. Click Delete Delete Delete Delete on the line of the file in question and confirm. 
4. Save the field in question and the term record (press Ctrl+SCtrl+SCtrl+SCtrl+S twice). 
 
If you want to replace a file that was attached according to the instructions above or add an 
informative text to be shown when you point to the object symbol: 
1. Edit the term record and right click on the image field in question. 
2. Choose Edit AttachmentsEdit AttachmentsEdit AttachmentsEdit Attachments. 
3. Click Edit Edit Edit Edit on the line of the file in question. 
4. Indicate any “display text" for the file (the object) in the Display nameDisplay nameDisplay nameDisplay name field and/or new 

object in the field Replace with fileReplace with fileReplace with fileReplace with file. 
5. Click SaveSaveSaveSave. 
6. Save the field in question and the term record (press Ctrl+SCtrl+SCtrl+SCtrl+S twice). 

Show a picture that is associated with a term recordShow a picture that is associated with a term recordShow a picture that is associated with a term recordShow a picture that is associated with a term record        
Some term records include links to web sites, explanatory images or other multimedia objects. 
In these cases a link with a different color or possibly text with a small image symbol is visible 
in the relevant field.  
When you click on one of the latter, the picture will be shown in a new window. 
Close the window with the picture by clicking the 'x' in the upper right-hand corner (or on the 
Close tab symbol or corresponding for tabbed browsing). 
 
Alternatively to symbols, thumbnails can be displayed (for attached jpg and gif illustrations): 
To show illustration thumbnails:  
Click SettingsSettingsSettingsSettings and check the Show thumbnails Show thumbnails Show thumbnails Show thumbnails box. 
To hide illustration thumbnails and show object symbols only: 
Click SettingsSettingsSettingsSettings and deselect the Show thumbnailsShow thumbnailsShow thumbnailsShow thumbnails check    box. 
 



 
19 (62) 

© 2011 Interverbum Technology AB  Admin_and_User_Manual_TWPro_V3.8_R1B_EN.rtf 2011-04-14 

 
 

Creating and displaying relationsCreating and displaying relationsCreating and displaying relationsCreating and displaying relations    
TermWeb allows you to define, edit and view relationships like subset, part-of, etc. for the 
concepts in your dictionary. Concept relations are also displayed graphically in a navigable map 
to let you find and view the related concepts in an easy way. The terms in the relation graphs 
are displayed in the currently selected source language. 
 
To display relations, click SettingsSettingsSettingsSettings and check the Show relatiShow relatiShow relatiShow relations ons ons ons check    box. 

 
To view a diagram of the current concept’s relations, click Show graph Show graph Show graph Show graph »»»». 
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Here, click View conceptView conceptView conceptView concept to go back to normal view. 
You define and delete relations under Add/EditAdd/EditAdd/EditAdd/Edit > Edit concept level fields Edit concept level fields Edit concept level fields Edit concept level fields     
If you click Add relationAdd relationAdd relationAdd relation, a list of terms is displayed. Find and select the term you want to create 
a relation to. Then define which relation the selected term has to the concept you started out 
working with.  
An example: If you start out working with the concept chassis, click Add relation, find the car 
concept and define the relation as Partitive and Superordinate, as car is superordinate to 
chassis. 
 

Printing term data Printing term data Printing term data Printing term data     
To print a selected subset of term data, either to a PDF file or to a printer, proceed as follows: 
1. Display the desired list of terms, using search criteria, filters etc.  
2. In the Search view, click the PrintPrintPrintPrint Icon. 
3.3.3.3. Now you can select whether to print only the concept currently displayed in the result 

window, or all concepts in the term list. Also, you can select to print to your standard printer 
(via html) or to a PDF file.  
In case you select normal (html) printout with the Print only the selected conceptPrint only the selected conceptPrint only the selected conceptPrint only the selected concept or Print Print Print Print 
all concepts in the current listall concepts in the current listall concepts in the current listall concepts in the current list radio button, you can choose to save the html file for later 
use. 
Furthermore, you can choose to add a list of contained concept ID numbers at the top of the 
printout by selecting Create a table of contentsCreate a table of contentsCreate a table of contentsCreate a table of contents.    

 
Please note that the fields appearing in the printout depend on the view used for your user 
group. 
 



 
21 (62) 

© 2011 Interverbum Technology AB  Admin_and_User_Manual_TWPro_V3.8_R1B_EN.rtf 2011-04-14 

 
 

 
 

Check the history of a term recordCheck the history of a term recordCheck the history of a term recordCheck the history of a term record    
To show a list of all the important changes made to a term record: 
4. Show the term record. Click on the term from the list so the content of the term record is 

visible in the result pane. 
5. Click SettingsSettingsSettingsSettings and select the Show history Show history Show history Show history box. An overview of changes made to the term 

record will appear. 
Click the link text under Action, e.g. "The concept was changed" if you want to see more 
information about the change. 

6. Deselect Show historyShow historyShow historyShow history when you want to hide the information. 
 
See also Undo changes in a term record. 
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What is a dictionary?What is a dictionary?What is a dictionary?What is a dictionary?    
A dictionary is a major part of the database of a given structure, e.g. a limited number of 
languages and fields. 
The fields may be valid for the entire term record (concept level fieldsconcept level fieldsconcept level fieldsconcept level fields), e.g. a definition. They 
may also be valid only or for a term in a particular language (term fieldsterm fieldsterm fieldsterm fields), e.g. grammar or 
source of a translation of a term in a particular language (a term equivalent).  
The administrator defines dictionaries. You specify which dictionary will be shown by clicking 
the scroll arrow beside the Dictionary Dictionary Dictionary Dictionary droplist and choosing the dictionary from the list. The list 
of terms in the chosen source language is then updated. 
More than one dictionary:More than one dictionary:More than one dictionary:More than one dictionary:    
There is possibly more than one dictionary available to you. In this case, you can either change 
which dictionary to view, search, and work with, as described above, OR select one ore more 
additional dictionaries to view and search in the same time as the main dictionary. 
Note!Note!Note!Note!    
You should only add, change, and delete concepts in the currently selected main dictionary. 

Selecting additional dictionariesSelecting additional dictionariesSelecting additional dictionariesSelecting additional dictionaries    

If there are more than one dictionary available, you can select one or more dictionaries (besides 
the main dictionary selected in the Dictionary droplist) to search in. These are referred to as 
additional dictionaries and are also selected in the same window as sections. 

1. Click the "All sections …" link or the < Change< Change< Change< Change button (to the right of the Dictionary 
droplist). 

2. Press and hold Ctrl and click the additional dictionaries you wish to select for searching. 

3. Click the SelectSelectSelectSelect button. The number of additional dictionaries is displayed in the link text 
and the term list is updated to include terms from selected additional dictionaries. Terms 
from additional dictionaries are displayed with pink background in the term list. 

Searching in additional dictionaries has some limitations compared to main dictionary 
searching:  

• Terms from all available sections are displayed from additional dictionaries. 

• Domain, filter and multi-field searches only return terms from the main dictionary. 

• Fuzzy search returns matches from main and additional dictionaries. 

• Editing of concepts is only possible in the main dictionary. 

When a concept from an additional dictionary is displayed in the result window, a message is 
shown at the top of the window with a link for setting the concept's dictionary as main 
dictionary. This provides a quick way of changing the main dictionary if you for example want to 
edit the concept. The previous selected main dictionary is automatically selected as additional 
dictionary when this link is used.  

If you change the main dictionary using the Dictionary droplist, the previous main dictionary is 
notnotnotnot selected as additional dictionary.  
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What is a sectionWhat is a sectionWhat is a sectionWhat is a section????    
A dictionary can contain a number of sections with various types of terms and phrases. For 
instance, there might be a section with terms that are still being worked on, one with 
abbreviations and acronyms, and one with approved terms that are standard in various 
languages.  
If you click on the "All sectionsAll sectionsAll sectionsAll sections … … … …" text, you will see all of the sections (and possibly additional 
dictionaries) that are available to you. 
You can choose to show terms from one or more of the sections: 
1. Click the < Change< Change< Change< Change button (or click the text, normally "X of Y sectionsX of Y sectionsX of Y sectionsX of Y sections … … … …", to the right of the 

Dictionary droplist). Usually the text “All sections All sections All sections All sections …………" is shown here. 
2. A list of available sections appears in a box in the result pane. Select the section that you 

want to search. Hold CtrlCtrlCtrlCtrl and select other sections that you want to search. 
3. Click SelectSelectSelectSelect. (Note that the term list gets a yellow background to signal that only terms from 

a subset of the available sections are displayed.) When you then click the < Change< Change< Change< Change button 
again, the names of the sections which you have selected appear in the Selections for Selections for Selections for Selections for 
searchingsearchingsearchingsearching box in the result pane. 

 
If you want to show terms from all the sections in a dictionary: 
1. Click the < Change< Change< Change< Change button (or click the text, normally "X of Y sectionsX of Y sectionsX of Y sectionsX of Y sections … … … …", to the right of the 

Dictionary: droplist). 
2. Click the word "AAAAllllllll" (Select AllAllAllAll) in the Sections in current dictionarySections in current dictionarySections in current dictionarySections in current dictionary part of the SeSeSeSelelelelections ctions ctions ctions 

for searching for searching for searching for searching box. 
3. Click the Select Select Select Select button at the bottom of the dialog box. 

Show a particular domain or subdomainShow a particular domain or subdomainShow a particular domain or subdomainShow a particular domain or subdomain    
The terms in a dictionary and its sections can be classified according to their subject areas, i.e. 
domains, such as DATA PROCESSING or BUSINESS & ADMINIST.  
If you want to only show terms from a single domain or subdomain: 
1. Tick the Domain search Domain search Domain search Domain search box.  

In order to show as much of the domain selection frame as possible, you can switch to full 
screen view (F11 in Internet Explorer). 

2. Select the desired domain(s).domain(s).domain(s).domain(s). If you select a domain, its subdomainssubdomainssubdomainssubdomains are also selected 
automatically. To select or remove subdomainssubdomainssubdomainssubdomains, first click the plus sign to the left of the 
main domain selected and then the subdomain(s)which you want to select. 
Click OKOKOKOK at the bottom of the result pane when you are finished. 

3. Only terms from the selected domains/subdomains will be visible in the chosen source 
language. 

You can see which domains and subdomains you have chosen in when you point to the heading 
[n] selected domains [change][n] selected domains [change][n] selected domains [change][n] selected domains [change] at the top of the result pane. 
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Move a term recordMove a term recordMove a term recordMove a term record    
To move a term record: 
1. Show the term record. Click on the term from the list so the content of the term record is 

visible in the result pane. 

2. Click the Edit Edit Edit Edit icon . 
3. Press Alt+OAlt+OAlt+OAlt+O (in Internet Explorer) or click on Edit concept level fields...Edit concept level fields...Edit concept level fields...Edit concept level fields.... 
4. Choose a different section from SectionSectionSectionSection box and press Alt+S Alt+S Alt+S Alt+S (in Internet Explorer) or click 

SaveSaveSaveSave at the bottom of the window when you are finished. 
5. Save the term record by clicking SaveSaveSaveSave. 

Remove a term record Remove a term record Remove a term record Remove a term record     
To remove an entire term record (e.g. a duplicate entry):  
(You can also remove a term record by moving it to a section for removed records by following 
the instructions under “Move a term record".) 
1. Show the term record. Click the term on the list so the content of the term record is visible 

in the result pane. 

2. Click the Delete Delete Delete Delete icon . 
3. Confirm that you wish to remove a term record by clicking DeleteDeleteDeleteDelete    in the text box shown. The 

term list is updated. 
 

Remove a termRemove a termRemove a termRemove a term    
You can remove a term equivalent from a term record as follows: 
1. Show the term record. Click on the term in the list to the left so that the content of the 

term record is visible in the result pane. 

2. Click the Edit Edit Edit Edit icon . 
3. Click once on the term you want to remove so that it is appears at the top of the result 

pane. 

4. Click Delete term Delete term Delete term Delete term  to confirm that you want to delete the term. 
(If you change your mind, press Alt+XAlt+XAlt+XAlt+X (in Internet Explorer) or click CancelCancelCancelCancel in the button 
field at the bottom of the window. You can also later use the Restore function in Show 
history.) 

5. Press Alt+SAlt+SAlt+SAlt+S (in Internet Explorer) or click SaveSaveSaveSave in the button field at the bottom of the 
window when you have finished updating the term record.  
The term list is updated. 
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Import and export term dataImport and export term dataImport and export term dataImport and export term data    
If allowed by the administrator, even if you are not an administrator, you may have the right to 
import and/or export data to and from certain sections of a dictionary. Please refer to sections 
“Import: To import term data” and “Export: To export term data” below. 

Send feedbackSend feedbackSend feedbackSend feedback        
This is how you send a message to the system administrator or the dictionary administrator: 
(To save a comment with a specific term or term record, please use the Add comment function.) 
 
1. Click on the mail symbol . 
2. Select the name of the addressee from the droplist in the ToToToTo field. 
3. Your name and email address should already be filled in (f registered by tha administrator). 

Otherwise, fill in these together with the subject and your message. You can also attach a 
file with additional information. (Attach). 

 
4. Click Send.Send.Send.Send. Confirmation that the message has been sent appears in the result pane. 
 

Log outLog outLog outLog out    
Click Log outLog outLog outLog out in the upper right-hand side of the window. 
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Administration Administration Administration Administration  (for administrators only) (for administrators only) (for administrators only) (for administrators only)    
 
If you click on the AdminAdminAdminAdmin icon in the search mode (with search field, term list and result pane 
visible) the following function icons will appear: 

� New Dictionary WizaNew Dictionary WizaNew Dictionary WizaNew Dictionary Wizardrdrdrd: Create/add a new dictionary 
� DictionariesDictionariesDictionariesDictionaries: Modify or remove a dictionary (languages, fields, layout), export the 

dictionary definition and create a new dictionary by importing a dictionary definition 
� SectionsSectionsSectionsSections: Add, rename and delete sections 
� HistoryHistoryHistoryHistory: View changes in the overall structure and content of a dictionary and “undo” 

the ones you do not want. If you want to “undo” changes (i.e. restore previous data)for a 
specific term, go to Search View > Settings > Show history. 

� Edit DEdit DEdit DEdit Domainsomainsomainsomains: Add, edit and delete domains and subdomains 
� SubclassesSubclassesSubclassesSubclasses: Add, edit and delete subclasses (groups of term records that can be located 

in different sections and are viewed in a certain way by all users, except administrators.) 
� Edit ViewsEdit ViewsEdit ViewsEdit Views: Add, change and remove views for a specific dictionary. Different views, such 

as differences in the information that is visible, can be selected for different user groups. 
Different views can be used, for example, to hide fields with exclusively administrative 
information from most users, except terminologists and administrators. 

� ImportImportImportImport: Import data with variable formats into TermWeb 3 
� ExportExportExportExport: Export a complete dictionary or a (filtered) part of a dictionary 
� File Repository:File Repository:File Repository:File Repository:    Work with objects like pictures, sound files, etc. in the internal TermWeb 

file repository, import and export objects in batch 
� Users:Users:Users:Users: Add, modify, deactivate/activate or delete a user 
� Groups:Groups:Groups:Groups: Add, modify and delete groups (with any filters and views) 
� Group Members:Group Members:Group Members:Group Members: Assign the user to one or more groups. 
� Guest AccountGuest AccountGuest AccountGuest Account: Activate/deactivate a guest account (for several simultaneous users 

without personal user names). Indicate automatic login or normal login to be associated 
with a guest user name and password. 

� Change Password:Change Password:Change Password:Change Password:    Change your own password 
� Access Editor:Access Editor:Access Editor:Access Editor: Select the level of user group(s’) access (no access, read access or read 

and write access) as well as export/import rights to various dictionaries and sections 
� Permission SchemesPermission SchemesPermission SchemesPermission Schemes:::: An alternative to Access Editor, providing a more detailed 

configuration of access permissions, including delete rights, and easier management.  
A permission scheme consists of a set of permissions granted for different user groups. 
The scheme is assigned to selected dictionaries and/or sections. 

� Lock Languages:Lock Languages:Lock Languages:Lock Languages: Select (for each applicable dictionary) which languages should not be 
editable for members of certain user groups 

� SSSScheduled Jobscheduled Jobscheduled Jobscheduled Jobs::::    Automate regular exports of terminology data that fulfill certain 
criteria. 

� Statistics:Statistics:Statistics:Statistics:    View usage statistics for the installation, listed per client, user etc. 
� WorkflowsWorkflowsWorkflowsWorkflows::::    Define and automate tasks, control access permissions on the field level, and 

add condition-dependent styling to your term data. 
� Administrator Tools:Administrator Tools:Administrator Tools:Administrator Tools:    Reindex dictionaries to speed up access. Customize message for 

error page. 
� ClientsClientsClientsClients    (can only be used by the system administrator): Add, modify or delete clients. 

Specify a maximum number of user accounts and/or a maximum number of individuals 
who can be logged in at the same time for each client. 
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Note! Note! Note! Note!  
� As an administrator you can always return to the window with the administrator 

function icons by clicking Admin ViewAdmin ViewAdmin ViewAdmin View in the upper left-hand side of the window. 
� You can always return to search view by clicking Search ViewSearch ViewSearch ViewSearch View in the bar to the left of 

Admin View. 
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New Dictionary Wizard: Add a new dictionaryNew Dictionary Wizard: Add a new dictionaryNew Dictionary Wizard: Add a new dictionaryNew Dictionary Wizard: Add a new dictionary    
Note that a section with the same name as the dictionary is always created as a dictionary is 
created. Note also that authority to a dictionary and its sections is always initially set as 
Undefined. You need to define the Users and User groups and their authority if you want to limit 
access to a dictionary. 

Dictionaries: Edit/delete dictionary, export/import dictionary definitionsDictionaries: Edit/delete dictionary, export/import dictionary definitionsDictionaries: Edit/delete dictionary, export/import dictionary definitionsDictionaries: Edit/delete dictionary, export/import dictionary definitions    
You can rename a dictionary as well as the language, concept and term level fields by clicking 
the dictionary name. Here, you can also define at which place the dictionary should be placed in 
the list of dictionaries (dictionary selector etc.). Type the desired order number in the Sort indexSort indexSort indexSort index 
field. Note that this has to be done starting at number 1, and preferably for all dictionaries in 
the database. 
LanguagesLanguagesLanguagesLanguages:::: 
For each language you choose to add to a dictionary (from a list of all languages, common 
languages of the world, or European Union languages), you can select to specify the following: 

• Possible geographical variants; regions (either predefined like US English, UK English, 
etc. or user-defined) 

• Possible orthographical variants; character sets (like traditional and simplified Chinese 
scripts) 

• If the language (or language variant) is written from left to right or right to left 
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The "language" Not applicableNot applicableNot applicableNot applicable can for example be used for manual numeric concept or item 
numbering or for lists of terms or acronyms common to more than one language. If a dictionary 
only containing "Not applicable" language terms is selected as main dictionary with another 
secondary dictionary, searches will present results from a) the main dictionary and b) terms 
from the first language in the additional dictionary. If a "normal" dictionary is selected as main 
dictionary with a secondary dictionary only containing "Not applicable" language terms, 
searches will present results from a) current source language terms of athe main dictionary and 
b) terms from within the set of "Not applicable" language terms.  
    
Field types:Field types:Field types:Field types: 
You can create single-line and multi-line text fields, incremental fields (the value of which is 
automatically recalculated for each new term record), as well as picklist fields (allowing the 
selection of one of several fixed values) and multivalued fields (allowing the selection of one or 
more of several fixed values). 
A multivalued field "Product(s)" with several values selected could for example be displayed as 
follows: Product A, Product C, Product D, Product V. Please note that values in 
multivalued field cannot contain the separator character , (comma). 
Character encoding, mandatory fields and min/max no. of characters allowed:Character encoding, mandatory fields and min/max no. of characters allowed:Character encoding, mandatory fields and min/max no. of characters allowed:Character encoding, mandatory fields and min/max no. of characters allowed: 
You can also indicate how character encoding of data, whether or not fields are mandatory, and 
the kind of data permitted in the field (see below) as well as the min./max number of characters 
allowed.  
If Unicode is selected for a field, then it is possible to write or copy in characters other than the 
Latin as well special characters, such as a dash. Note that the term field (in all languages) is 
specified as Unicode. 
Mandatory fields are indicated by an asterisk. If you try to save a term record without filling in a 
mandatory field, an error message will appear and/or the field will be indicated with a colored 
background. 
Data type (Allowed value):Data type (Allowed value):Data type (Allowed value):Data type (Allowed value): 
In addition you can indicate what kind of data is allowed in the field, i.e. any text, integer 
number (without a decimal or comma to indicate thousands, max 9 characters), or data that 
corresponds with a regular expression. An example of the latter is the simplest form of syntax 
control of the date, i.e. 20YY-MM-DD: 
20\d{2}(-)((0[1-9])|(1[0-2]))(-)((0[1-9])|([1-2][0-9])|(3[0-1])) 
 
If you want to add your own definition of a field on the concept level, with a limited number of 
possible values, do as follows: 

1. Click the dictionary’s name. 
2. Click Add...Add...Add...Add... in Concept Level Fields. 
3. Select New custom fieldNew custom fieldNew custom fieldNew custom field and then click ConConConContinuetinuetinuetinue. 
4. Enter the field name. 
5. Specify the type of field in Field typeField typeField typeField type (Picklist). 

Note! A single-line field can theoretically contain a maximum of 16,383 characters, but 
as the name indicates it is intended for less information, e.g. a maximum of about 70 
characters which can be shown on one line in the result window without sideway 
scrolling. 
A multi-line field can contain a maximum of 16,383 characters, if not otherwise 
specified under Data length limit. 

6. Select LatinLatinLatinLatin----1111 in EncodingEncodingEncodingEncoding if the field only will include Latin characters. 
7. Select Value is requiredValue is requiredValue is requiredValue is required if the field must be given a value when a term record is created. 
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8. Click Add...Add...Add...Add... beside the box for "Picklist items". 
9. Enter one of the fixed values in the typing field and click SaveSaveSaveSave beside the typing field. 
10. Repeat step 9 for other possible values. 

Note that the value you write in first will be shown at the top of the list.  
If necessary you can move the various values up or down in the list. 
If the field is defined as mandatory, then the upper value of the list will be filled in 
automatically when someone creates a new term record. 

11. Click SaveSaveSaveSave at the bottom of the box. 
12. Click Save ChangesSave ChangesSave ChangesSave Changes if you do not want to add or change more fields. 

 
Note! Initial zeros in numerical fields are automatically truncated when the term record is 
saved. 

Export a dictionary definitionExport a dictionary definitionExport a dictionary definitionExport a dictionary definition    

This is how to create a file with a certain dictionary structure (fields and sections): 
1. Click DicDicDicDictionariestionariestionariestionaries. 
2. Click Export Export Export Export beside the dictionary from which you want to export the definition.  

(If you want to export the dictionary definition to MultiTerm XDT format, click Export Export Export Export 
XDT fileXDT fileXDT fileXDT file beside the dictionary from which you want to export the definition.) 

3. Save the resulting XML file in an appropriate location and with an appropriate name. 
Note!Note!Note!Note! Only the dictionary structure is exported, no term data, user data or access rights 
data is exported 

 

Import a dictionary definitionImport a dictionary definitionImport a dictionary definitionImport a dictionary definition    

This is how to create a new dictionary with the same structure (fields and sections) as one 
which you have previously exported: 

1. Click DictionariesDictionariesDictionariesDictionaries. 
2. Click BrowseBrowseBrowseBrowse and choose an exported dictionary definition file from the Import Import Import Import 

dictionary definition from file dictionary definition from file dictionary definition from file dictionary definition from file box.... 
3. Click Import dictionaryImport dictionaryImport dictionaryImport dictionary and a dictionary with the same languages, fields and 

characteristics as the previously exported dictionary is created. If you import the 
dictionary definition while logged on as the same client that created the original 
dictionary, the new dictionary will have the same name as the exported dictionary 
definition but with an added number, e.g. (2). 
Note! Note! Note! Note! Term information is not imported, but you can import it via (Export and) Import in 
Admin View. 

Edit dictionary layoutEdit dictionary layoutEdit dictionary layoutEdit dictionary layout    

If you want to change the appearance (character size, color etc.) of the field names and/or text, 
please do as follows: 

1. Click DictionariesDictionariesDictionariesDictionaries. 
2. Click Edit LayoutEdit LayoutEdit LayoutEdit Layout on the line of the relevant dictionary. 
3. Change the style parameters as desired. 
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An example of a CSS file (Cascading Style Sheets, that decides the appearance of the 
terminology display window): 
/* $Date: 2007/04/05 15:01:44 $ */ 
span {font-family:verdana;font-size:11px} 
br {display:none} 
div {text-align:left} 
div.t {margin:10px 0} 
.l {white-space:nowrap} 
.d {margin-left:1em} 
.d br {display:inline} 
.I_dom .l {display:block;float:left} 
.I_dom .d {display:block;float:left;margin-left:5px} 
.md {background:#eef;padding:.2em .4em} 
.md .d {white-space:nowrap} 
.md .f {display:inline;margin-right:20px} 
.md .f span {font-size:9px} 
.md .f .l {color:#99d;font-weight:bold} 
 
.cf {display:block;margin:20px 0} 
.cf .f{display:block;font-weight:bold} 
.cf .f .l {color:#99d} 
.cf .f .d {color:#999} 
 
.f .l {color:blue;font-weight:bold} 
.f {display:block} 
 
.t,.tc {text-align:left} 
 
.tx * {margin-left:20px} 
.tx .t {margin-top:0} 
.tx .md {margin:1em 0 0 40px} 
.tx .md * {margin-left:0} 
.tx .md .d {margin-left:1em} 
.tx a, .tx img {margin-left:0} 
.tx .ILANG {display:block} 
.tx .ILANG .d {font-size:13px} 
.tx .ITERM .d {font-size:15px;font-weight:bold} 
 
 
.tc {display:table} 
.tc .t {margin:.2em 0;display:table-row} 
.tc .ILANG {display:table-cell} 
.tc .ITERM  {display:table-cell} 
.t .ILANG .l {display:none} 
.t .ILANG .d {font-weight:bold;color:red} 
.t .ITERM .l {display:none} 
Note!Note!Note!Note!    
You can always revert to the original layout for the dictionary at any time by clicking Use Use Use Use 
Default CSSDefault CSSDefault CSSDefault CSS.... 

Color of field 
labels (acc. 
to CSS color 
names) 

(Font and) 
font size of 
displayed data 

Color of 
language 
names 
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Sections: Working with sectionsSections: Working with sectionsSections: Working with sectionsSections: Working with sections    
This is where you add, modify and delete sections. 

� You add a section by clicking New SectionNew SectionNew SectionNew Section, specifying the name and dictionary for 
the section and then clicking SaveSaveSaveSave. Here, you can also define at which place the 
section should be placed in the list of sections (section selector etc.). Type the 
desired order number in the Sort indexSort indexSort indexSort index field. Note that this has to be done starting 
at 1, and preferably for all sections in the dictionary. 

� You change the name of the section by clicking the section’s name on the list. 
� You remove a section by selecting the box beside the section’s name on the list and 

clicking Delete Selected...Delete Selected...Delete Selected...Delete Selected....  
Note!Note!Note!Note! When you remove a section you also delete all content, i.e. all term records in 
the section!!! 

User groups that should be able to read the terms in the section and change, add or remove 
term records (and export and import data) in the section are described under Access Editor. 
 

History: Show changes in History: Show changes in History: Show changes in History: Show changes in a a a a dictionary and undo changesdictionary and undo changesdictionary and undo changesdictionary and undo changes    
If you wish to undo an import, you can do for example as follows: 
1) Choose the desired dictionary. 
2) Click on the arrow (in the Restore column) alongside the position to which you want to 

restore the database. 

 
3) Confirm that you want to restore the database to the selected position (e.g. 21 February 

9:05). 
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Note!Note!Note!Note!    The dictionary history only runs back to the latest change of the dictionary structure. 
 

Edit Domains: Add, edit and delete domains and subdomainsEdit Domains: Add, edit and delete domains and subdomainsEdit Domains: Add, edit and delete domains and subdomainsEdit Domains: Add, edit and delete domains and subdomains    
How to specify domains and subdomains. While working you can show or hide subdomains by 
clicking on their name. 
 
Add a domain: 
1. Select the desired dictionary from the Dictionary Dictionary Dictionary Dictionary droplist. 
2. Right click All domainsAll domainsAll domainsAll domains and choose Add domainAdd domainAdd domainAdd domain. 
3. Write over the text "New domain" shown in the box at the bottom of the domain list with 

the name of your new domain. 
Tips (in Internet Explorer): Press shift+Ctrl shift+Ctrl shift+Ctrl shift+Ctrl and type in the name. Confirm by pressing Enter. 

4. Repeat steps 2 and 3 for all main domains. 
If you want to have subdomains: 

5. Right click on a domain and choose Add domainAdd domainAdd domainAdd domain. 

 
6. Write over the text New domain in the box that appears with the name of the subdomain 

and confirm by pressing Enter. 
7. Repeat steps 5 and 6 for all subdomains of a main domain. 
8. Repeat steps 5 and 6 also for other main domains that are to have subdomains. 
 
To rename a domain: 
1. Right click on the domain name and choose Edit domainEdit domainEdit domainEdit domain. 
2. Write over the domain name that is shown in the box with the new domain name. 
3. Confirm by pressing Enter. 
 
To remove a domain: 
1. Right click on a domain and choose Delete domainDelete domainDelete domainDelete domain. 
2. Confirm with OKOKOKOK (or undo by pressing CancelCancelCancelCancel). 
Note!Note!Note!Note! When you remove a domain, the term records that belonged to that domain will then 
belong to the nearest preceding domain (above). 
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Subclasses: Create subclasses of term recordsSubclasses: Create subclasses of term recordsSubclasses: Create subclasses of term recordsSubclasses: Create subclasses of term records    
Terms in a certain subclass can be found in several different sections of a dictionary. 
A subclass for a term record is created among the general fields in the same way as for a 
section (Edit concept level fields). 
Subclasses of term records can be used for two different purposes: 
1) To show term records in the subclass in the same way (with the same view) for all users 
except the administrator.  
2) To limit a specific user group to viewing term records of a certain subclass only.  
 
A) How to create the same view of a subclass for all users except the administrator: 
(You can otherwise create a user-group specific view under “Groups".)  

1) Create a new view, e.g. without administrative information. See Edit ViewsEdit ViewsEdit ViewsEdit Views 

 
2) Create a subclass: Click New subclassNew subclassNew subclassNew subclass, type in the name of the new subclass, select the 

dictionary for which the subclass is to be valid and choose the view created in step 1. 
 
B) How to create a subclass that is user-group specific: 

1) Create a filter with the condition that term records belong to a specific subclass 
(Subclass EQUALS...). 

2) Apply this filter to the user group. 
This user group will then only see the term records that belong to this subclass, and with the 
view that has been specified for the subclass. 
 

Edit Views: Add, change, and delete views for a specific dictionary.Edit Views: Add, change, and delete views for a specific dictionary.Edit Views: Add, change, and delete views for a specific dictionary.Edit Views: Add, change, and delete views for a specific dictionary.    
For example: If you want to hide the fields “Created by", “Creation date", “Changed by", and 
“Change date", on the term level for a specific user group, do as follows: 

1) Click Edit ViewsEdit ViewsEdit ViewsEdit Views. 
2) Click Add view...Add view...Add view...Add view.... 
3) Give the view a descriptive name. 
4) Specify which dictionary applies. 
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5) Deselect the fields that are to be hidden from view. 

 
6) Click Create viewCreate viewCreate viewCreate view. 
7) Click Admin ViewAdmin ViewAdmin ViewAdmin View and then GroupsGroupsGroupsGroups. 
8) Click the group’s name. The Group dataGroup dataGroup dataGroup data dialog appears. 
9) For each dictionary, Ctrl-click the view or views to be available to the group in the ViewViewViewView: : : : 

droplist and then click Update GroupUpdate GroupUpdate GroupUpdate Group. 

 
The users in the group will then not be able to see the deselected fields in the view or edit mode 
(assuming that the group has Write access to a part of the relevant dictionary). 
 
When a member of the group logs in, he or she will be able to choose between the available 
views (if more than one view was selected above): 
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Import: To import term data Import: To import term data Import: To import term data Import: To import term data     
 

1) Click ImportImportImportImport. 
2) If you want to import terminology data using an existing settings file, select the setting 

file/dictionary name under Available settingsAvailable settingsAvailable settingsAvailable settings and click ImportImportImportImport.  
To change an existing settings file, select it and then click EditEditEditEdit. 
To create new settings file click New...New...New...New..., name the settings, choose a dictionary from the 
Import in DictionaryImport in DictionaryImport in DictionaryImport in Dictionary droplist, and specify the new settings for import synchronization, 
i.e. how the import file will be synchronized with existing information in the section, 
what will be imported, etc.  
Click SaveSaveSaveSave, select the settings file and click ImportImportImportImport. 

3) Click Browse,Browse,Browse,Browse, scroll down and choose the file you want imported. 
4) Click Next >Next >Next >Next >.  
5) Click Next > Next > Next > Next > if the validation report is OK. 
6) Unless already decided, select to what dictionary section the terminology data should be 

imported by mapping the dictionary section(s) to the section name(s) in the import file 
and then click NextNextNextNext. 

7) If there are fields on the term record (concept) level in the import file that were not 
already connected (mapped) with the fields in the dictionary, select the fields that 
should be mapped and then click MapMapMapMap for one field name pair at a time in the Map Map Map Map 
concept fields concept fields concept fields concept fields text box. 
When you are finished, click NexNexNexNext >t >t >t >.  

8) Repeat step 7 if necessary on the term level (Map term fieldsMap term fieldsMap term fieldsMap term fields) and then click Next >Next >Next >Next >. 
9) Repeat step 7 is necessary for languages (Map languagesMap languagesMap languagesMap languages) and then click Next >Next >Next >Next >. 
10) If you are satisfied with the mapping, click Next >Next >Next >Next > in the Import settings complete Import settings complete Import settings complete Import settings complete text 

box. 
11) Click Finish Finish Finish Finish in the Import complete Import complete Import complete Import complete box. 

Note! The next time you want to import a similar file, the settings for mapping the 
import file and dictionary will be saved. 

 
Note! Note! Note! Note! When importing data from a file in the TermWeb 2 XML format: 
� If you want the same Concept ID in TermWeb 2 to apply in TermWeb 3: Tick "Synchronize on 

concept ID".  
� If you want to create a new Concept ID for term records: Tick “Add import concept as new" 

(recommended). 
For any supplementary import of previously exported and supplemented TermWeb 2 data, 
tick "Synchronize on index term". 
Note! Note! Note! Note! Any domain information in the import file will be transferred to the database only if 
the domain or subdomains already exist in the database. 

Example:Example:Example:Example:    
You have received an Excel file with new terms in French and Dutch and want to import data to 
the existing database where there are already terms in other languages. Use the import settings 
indicated in the figure below.  
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Use "Merge parts", however, if you want to supplement with new terms andandandand possibly new 
detailed information about existing terms. 
 

Import settingsImport settingsImport settingsImport settings    

An import setting defines how a file should be imported. You can define which fields and 
languages that should be affected, and also specify how concept and terms should be 
synchronized. 

Select a settingSelect a settingSelect a settingSelect a setting    

Your available settings are displayed in the import settings selection view when you click on the 
ImportImportImportImport button in the Admin view. You will see both your own settings as well as settings 
defined by other users and declared to be public. If you are an administrator all import settings 
for all users are displayed (both private and public). 
Click on an import setting to select it and then click the ImportImportImportImport button to start the import 
wizard. 

Create or edit a settingCreate or edit a settingCreate or edit a settingCreate or edit a setting    

To add a new setting, click the NewNewNewNew button in the import settings selection view. To edit a 
setting, click the EditEditEditEdit button for the setting you want to edit. You will see the settings editor 
where you define your import setting. 
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Start by entering a name for the settings. The name must be unique among all your defined 
import settings. 

Select the dictionary in which the file should be imported. You can only select from the 
dictionaries where you have import permissions. 

Select the visibility for the settings. Private means that only you and administrator users will be 
able to use the setting. Selecting Public lets all users with import permission in the dictionary 
use the settings. 

SynchronizationSynchronizationSynchronizationSynchronization    

With the synchronization features you can combine existing term data with imported data, e.g. 
adding translations for existing terms. You specify how concepts should be recognized for 
synchronization, and what action should be performed in that case. The preferred way of 
synchronizing concepts is to use the Concept ID, but TermWeb also lets you synchronize on 
index term. Since TermWeb 3.5 you also have the possibility to synchronize on Term ID on the 
term level. 

Concept synchronization methodsConcept synchronization methodsConcept synchronization methodsConcept synchronization methods    

The following methods are available for concept synchronization: 

• Add concept as newAdd concept as newAdd concept as newAdd concept as new - No synchronization is performed, the imported concept is always added as a new 
concept and given a new concept ID. 

• Synchronize on concept IDSynchronize on concept IDSynchronize on concept IDSynchronize on concept ID - The imported concept is matched against any existing concept with same ID 
in the database. If no such concept exists, the imported concept is added as a new concept, and its 
concept ID is kept as is. 

• Synchronize on index termSynchronize on index termSynchronize on index termSynchronize on index term - The imported concept is matched against any existing concept with at least 
one term with same name in any of the selected languages. If no such concept exists, the imported 
concept is added as a new concept and given a new concept ID. You need to select at least one language 
for synchronization with this option. 

Selected languages for index term synchronization does not affect which terms are imported, only which terms 
should be checked for concept synchronization.    
    
Synchronization ActionSynchronization ActionSynchronization ActionSynchronization Action    

The Synchronization Action defines what should be done with synchronized concepts. You can 
select one of the following actions: 

• Do not importDo not importDo not importDo not import - No changes are done to the existing concept and no new concept is added. 

• Replace old conceptReplace old conceptReplace old conceptReplace old concept - The existing concept is deleted and the imported concept is saved. 

• Overwrite partsOverwrite partsOverwrite partsOverwrite parts - Selected parts from the imported concept is used to overwrite parts of the existing 
concept. See more details below. 

• Merge partsMerge partsMerge partsMerge parts - Selected parts from the imported concept is merged into the existing concept. See more 
details below. 

• Fill in partsFill in partsFill in partsFill in parts - Selected parts from the imported concept is filled in into the existing concept. See more 
details below. 
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Selecting partsSelecting partsSelecting partsSelecting parts    

You select the parts of the imported conceptimported conceptimported conceptimported concept that you wish to use for updating the existing 
concept in the database. You can select any field on the concept level, and/or terms in selected 
languages. Selected parts from the import concept are then used to update the synchronized 
concept, according to selected action. 

The term entries in the synchronized concepts can also be synchronized. You can select how 
TermWeb should attempt to synchronize the term entries in the Term synchronization settings. 

When two term entries are synchronized, every field value of the term entries is handled 
depending on selected action: 

• Overwrite partsOverwrite partsOverwrite partsOverwrite parts - The imported field value always overwrites the existing value, or deletes it if the 
imported value was empty. 

• Merge partsMerge partsMerge partsMerge parts - The imported field value overwrites the existing value, but the existing value is kept if the 
imported value was empty. 

• Fill in partsFill in partsFill in partsFill in parts - The imported field value is only added if there was no existing value for the field. 

Same rules also applies for concept level fields. 

For imported term entries that not are synchronized the actions behaves as follows: 

• Overwrite partsOverwrite partsOverwrite partsOverwrite parts - All existing non-synchronized term entries in the imported term entry's language are 
deleted, and replaced by the imported term entries. 

• Merge partsMerge partsMerge partsMerge parts - The imported term entry is added to the existing concept. 

• Fill in partsFill in partsFill in partsFill in parts - The imported term entry is only added if there was no existing term entry in the imported 
term entry's language. 

Term synchronization settingsTerm synchronization settingsTerm synchronization settingsTerm synchronization settings    

You can select how term entries should be synchronized within synchronized concepts. The 
options are as follows: 

• Synchronize on term IDSynchronize on term IDSynchronize on term IDSynchronize on term ID - The imported term entry is synchronized with any existing term entry with same 
term ID. This option is only available if Synchronize on concept ID is selected. 

• Synchronize on similaritySynchronize on similaritySynchronize on similaritySynchronize on similarity - The imported term entry is compared to the existing term entries, and if there 
is enough similarity between the entries, they are synchronized. The fields being compared are term name, 
language, region and orthographical variant, and the probability for synchronization match depends on 
the combination of matching values in these fields. Two entries with same term name and language are 
always synchronized. 

• No synchronizationNo synchronizationNo synchronizationNo synchronization - No term synchronization is performed 

Term entries can only be synchronized within synchronized concepts, e.g. entries with matching 
term IDs will not be synchronized if their concepts not are synchronized. 

When you are done defining your import settings, click the SaveSaveSaveSave button to save them, or CancelCancelCancelCancel 
to leave the editor without saving your changes. 

    
Note!Note!Note!Note! If you want to “undo" a data import and restore the database to the position prior to the 
import, select Admin > HistoryAdmin > HistoryAdmin > HistoryAdmin > History. It is not possible to “undo" a complete data import by using the 
history function for a term record. 
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Note!Note!Note!Note! The metadata fields cannot be changed by editing the file to be imported. The "Created 
by", "Creation date", and "Change date" fields are set to the importer's ID and time of the 
import.  

Importing using PermiImporting using PermiImporting using PermiImporting using Permission Schemesssion Schemesssion Schemesssion Schemes    

When term data is imported with Permission Schemes enabled the same permissions are 
enforced as for manual editing. 

This means, that besides allowing the Import permission in the scheme, some other permissions 
should also be granted depending on what the users should be able to do during the import 
operation. 

The table below describes what permissions are needed for different import and synchronization 
cases: 

Import typeImport typeImport typeImport type    
Synchronization Synchronization Synchronization Synchronization 

typetypetypetype    
Permissions needed (for type of Permissions needed (for type of Permissions needed (for type of Permissions needed (for type of 

change)change)change)change)    

Import as new N/A 
Create ConceptCreate ConceptCreate ConceptCreate Concept (for importing new 
concepts) 

Replace old 
concept 

Create ConceptCreate ConceptCreate ConceptCreate Concept and Delete ConceptDelete ConceptDelete ConceptDelete Concept 
(all changes) 

Overwrite parts 

Edit ConceptEdit ConceptEdit ConceptEdit Concept (all changes) 
Edit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level Fields (for changes 
to concept level fields) 
Create TermCreate TermCreate TermCreate Term and Delete TermDelete TermDelete TermDelete Term (for all 
changes to non-synchronized terms) 
Edit TermEdit TermEdit TermEdit Term (for changes to synchronized 
terms) 

Merge parts 

Edit ConceptEdit ConceptEdit ConceptEdit Concept (all changes) 
Edit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level Fields (for changes 
to concept level fields) 
Create TermCreate TermCreate TermCreate Term (for all changes to non-
synchronized terms) 
Edit TermEdit TermEdit TermEdit Term (for changes to synchronized 
terms) 

Import with concept synchronization 
(on concept ID or index term) 

Fill in parts 

Edit ConceptEdit ConceptEdit ConceptEdit Concept (all changes) 
Edit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level FieldsEdit Concept Level Fields (for changes 
to concept level fields) 
Create TCreate TCreate TCreate Termermermerm (for all changes to non-
synchronized terms) 
Edit TermEdit TermEdit TermEdit Term (for changes to synchronized 
terms) 
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Export: To export term data Export: To export term data Export: To export term data Export: To export term data     
To export term data, e.g. for review or supplementary information, you can do the following:  
If you do not want to export an entire dictionary, create a filter under Search viewSearch viewSearch viewSearch view > FiltersFiltersFiltersFilters.  
1. Click ExportExportExportExport. 
2. Select a completed settings file from Available settings. 

To change an existing settings file, select it and then click EditEditEditEdit. 
If there are no appropriate export settings files for the dictionary, create a new (New...). 
Write the name of the export settings file, for which dictionary it is applicable, whether the 
export settings are to be visible for you only (Private) or for other users (Public) and the 
desired format of the export file. 

You can choose one of the following formats: 
- TBX (TermBase eXchange); standard format according to ISO/DIS 30042 
- TermWeb 2 XML; compatible with previous versions of TermWeb  
- MultiTerm iX XML 
- Excel; section names become a tab names, language and field names become a column names. 
Then choose the filter in the Select concepts by filter Select concepts by filter Select concepts by filter Select concepts by filter field. 
Indicate which languages and fields you want in the export file.  
Click SaveSaveSaveSave when you have finished with the export settings. 
3. Select the export settings file and click ExportExportExportExport. 
4. A picture is now shown with the mapping between the language names from the dictionary 

and export files. If you want to change something, you can rename the export file. 
Otherwise, click Next >Next >Next >Next >.  

5. A picture with the mapping between the concept level fields is shown as described above. 
Change as needed (does not apply to pre-defined TBX field names) and then click Next >Next >Next >Next >. 

6. A picture with the mapping between the field names at the term level fields is shown. 
Change as needed and then click Next >Next >Next >Next >.  
The Export complete!Export complete!Export complete!Export complete! box is shown with information about the number of exported term 
records. 

7. Click Open in browserOpen in browserOpen in browserOpen in browser if you want to review the file. Click Save fileSave fileSave fileSave file and save the file at an 
appropriate location and with an appropriate name. 

8. Click FinishFinishFinishFinish when you are finished. 
 
Note! You can use the same export settings, with minor modifications if necessary, the next 
time you want to create a similar export file. 
Note! If you want to check an exported TBX file, the dtd file TBXcdv04.dtd must be in the same 
folder as the TBX file. 
Note!Note!Note!Note! Concept relations and attached objects are not included in the export file. Externally 
linked objects are included but not (apart from web addresses) reimportable. For export of an 
entire dictionary, internal links (cross-references between concepts) are included and 
recreatable during import to another installation, but e.g. file repository data and embedded 
objects have to be packed and copied separately to the new installation. 
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Groups: Add, modify or delete groupsGroups: Add, modify or delete groupsGroups: Add, modify or delete groupsGroups: Add, modify or delete groups    
If necessary, you can add a new user group. 
You can also use a standard filter (for a certain dictionary) and a view (for a certain dictionary) 
for the group, but they should be specified first, see the sections “Use filters to search and 
export" and “Edit Views: Add, change and delete views for a specific dictionary."  
You can also change the name, description, filter and view for the group, or remove the group.  
Group members are specified under Group MembersGroup MembersGroup MembersGroup Members.  
Which members are to receive access to which sections of dictionaries is set under Access EditorAccess EditorAccess EditorAccess Editor    
(or by using Permission SchemesPermission SchemesPermission SchemesPermission Schemes, defining a set of rights for the user groups and then assigning 
this permission scheme to the desired dictionary or section). 

Add a groupAdd a groupAdd a groupAdd a group    

1. Click GroupsGroupsGroupsGroups. 
2. Click the New New New New icon. 
3. Indicate the name of the user group, description, and any view or filter that is to be 

applicable for the group. Filter and view can be set individually for each dictionary. 
(Views are defined under Edit ViewsEdit ViewsEdit ViewsEdit Views and filters under Search ViewSearch ViewSearch ViewSearch View > FiltersFiltersFiltersFilters.) 

4. Click Create GroupCreate GroupCreate GroupCreate Group. 

Change information about a groupChange information about a groupChange information about a groupChange information about a group    

1. Click GroupsGroupsGroupsGroups. 
2. Click the user group’s name. 
3. Change the name, description, and any filter and view (or views) (per dictionary) that are 

applicable to the group. 
An example:  

Here, no initial filter, but the view "Minimal view TT" is selected for the current group and 
the "TechniTerm and more" dictionary. To deselect a filter, select "No filter - All concepts 
visible" To deselect one or more views, Ctrl-click the currently selected view or views. 

4. Click Update GroupUpdate GroupUpdate GroupUpdate Group. 

Remove a groupRemove a groupRemove a groupRemove a group    

1. Click GroupsGroupsGroupsGroups. 
2. Tick the box to the left of the user group name. 
3. Click Delete Selected..Delete Selected..Delete Selected..Delete Selected... 

Guest Account: Activate/deactivate and change information about guest usersGuest Account: Activate/deactivate and change information about guest usersGuest Account: Activate/deactivate and change information about guest usersGuest Account: Activate/deactivate and change information about guest users    
1. Click Guest AccountGuest AccountGuest AccountGuest Account. 
2. Activate a guest account by ticking the box Enable guest accountEnable guest accountEnable guest accountEnable guest account. 
3. a) If the guest user is to log in the usual way: Fill in the user name and password and select 

NormalNormalNormalNormal. 
b) If the guest user is to log in automatically when they visit the web site: Select AutomaticAutomaticAutomaticAutomatic. 

4. Click SaveSaveSaveSave. 
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Everyone who visits the web site will now be able either to log in 
a) with the specified user name and password or  
b) automatically. 
Note! Note! Note! Note! Several users can use the guest account at the same time. 
What guest users can see is set under Access EditorAccess EditorAccess EditorAccess Editor or Permission Schemes Permission Schemes Permission Schemes Permission Schemes and with filter and 
views per dictionary for the user group GuestsGuestsGuestsGuests.  
Guest users cannot change term data; they can only search for terms, use pre-defined filters 
and create temporary filters. If you want, you can easily deactivate the guest account by 
clicking Guest AccountGuest AccountGuest AccountGuest Account, deselecting Enable guest accountEnable guest accountEnable guest accountEnable guest account and clicking SaveSaveSaveSave. 
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Users: Add, edit, deactivate/activate or delete a userUsers: Add, edit, deactivate/activate or delete a userUsers: Add, edit, deactivate/activate or delete a userUsers: Add, edit, deactivate/activate or delete a user    

Add a userAdd a userAdd a userAdd a user    

1. Click UsersUsersUsersUsers. 
2. Type in a user name, full name, e-mail address, password (twice) and primary group 

membership (and indicate if the user is to be an administrator or system administrator). 
Note! If you have not defined any group membership this can also be done under GroupGroupGroupGroupssss. 

    
3. Click Create UserCreate UserCreate UserCreate User (and then Admin View Admin View Admin View Admin View if you want to return to the administrative function 

icons or Search ViewSearch ViewSearch ViewSearch View if you want to return to the search position). 

Change information about a userChange information about a userChange information about a userChange information about a user    

1. Click UsersUsersUsersUsers. 
2. Click the user’s name. 
3. Make changes in the user data. Select "Inactive" if you want to temporarily deactivate the 

user. 
4. Click Update UserUpdate UserUpdate UserUpdate User. 

Remove a userRemove a userRemove a userRemove a user    

1. Click UsersUsersUsersUsers. 
2. Tick the box to the left of the user's name. 
3. Click Delete Selected..Delete Selected..Delete Selected..Delete Selected... 
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Group Members: Indicate which user is a member of a particular group and to Group Members: Indicate which user is a member of a particular group and to Group Members: Indicate which user is a member of a particular group and to Group Members: Indicate which user is a member of a particular group and to 
which groups a particular user belongswhich groups a particular user belongswhich groups a particular user belongswhich groups a particular user belongs    
Place users in one or more groups. 

 
Columns can be sorted (ascending or descending) on the basis of the group name, number of 
users, or user names by clicking on the relevant column heading. 
You can either click a group name to find out which users are members of the group or click on 
a user name to find out and change the groups to which a user belongs. You move users and 
groups by selecting the name, using the blue arrows to move them, and then confirming by 
clicking ApplyApplyApplyApply. 
When you have completed the task click Admin Admin Admin Admin ViewViewViewView or Search ViewSearch ViewSearch ViewSearch View. 

Access EditorAccess EditorAccess EditorAccess Editor: Set the user group access to dictionaries and sections: Set the user group access to dictionaries and sections: Set the user group access to dictionaries and sections: Set the user group access to dictionaries and sections    
You can specify the following for every combination of dictionary, section and user group:  
- which groups can read (or not) the terms in the section (Read AccessRead AccessRead AccessRead Access or No accessNo accessNo accessNo access). 
- which groups can add and edit terms in the section (Read/Write accessRead/Write accessRead/Write accessRead/Write access) 
- which groups can export, import, or both export and import data in the section 
Note that the status for a specific term record can also determine who is able to view and work 
with a term record. 
Note!Note!Note!Note! Authority for the Default group to All dictionaries/All sections should normally be set to 
No accessNo accessNo accessNo access after an administrator group with at least the member Admin is created. 
You can then give different authorities to the groups you create in the system. 

Example of procedures for authority settingsExample of procedures for authority settingsExample of procedures for authority settingsExample of procedures for authority settings    

This part of the manual is for a newly installed program (but there must be sections).  
When setting authority settings at a later point in time, points 1-3 can be skipped. 
1. Create a group for administrator(s). 

Click GroupsGroupsGroupsGroups > New GroupNew GroupNew GroupNew Group and then specify the name and description of the group. 
2. Specify who will be included in the administrator group. Directly after installation, it is the 

pre-defined user admin.  
Click Group MembersGroup MembersGroup MembersGroup Members and then the admin group’s name. Select Admin and move admin to 
the Users in groupUsers in groupUsers in groupUsers in group box with the blue arrow. Click AAAApplypplypplypply and then Admin ViewAdmin ViewAdmin ViewAdmin View. 

3. Remove general authority for everyone. 
Click Access EditorAccess EditorAccess EditorAccess Editor and choose  
Read/Write AccessRead/Write AccessRead/Write AccessRead/Write Access for the admin group 
and 
No access No access No access No access for the Default group. 

4. Create the user groups that are needed (groups of people that will have special authority to 
at least one section).  
Click GroupsGroupsGroupsGroups > New GroupNew GroupNew GroupNew Group and specify for one group at a time name, description and which 
views and filters will apply to the TermWeb dictionaries. 
Click Create GroupCreate GroupCreate GroupCreate Group and Admin ViewAdmin ViewAdmin ViewAdmin View when you are finished. 
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5. Create the users that will be in the system. 
Click UsersUsersUsersUsers > New UserNew UserNew UserNew User and specify user name, full name, and password. You can also 
choose which Initial group the user will be a member. (Note! A user can belong to several 
groups.) Finish by clicking Create UsCreate UsCreate UsCreate Userererer for each user.  
Click Admin ViewAdmin ViewAdmin ViewAdmin View when you are finished. 

6. Place the users in groups under Group Members Group Members Group Members Group Members as needed. 
7. Specify authority for each group under Access Editor.Access Editor.Access Editor.Access Editor. 

When All Dictionaries and All Sections are chosen:  
Specify No accessNo accessNo accessNo access for all groups except the administrator's group. 
Then specify authority per dictionary and section.  

Note!Note!Note!Note! If you import a new section of a dictionary, the authority for the dictionary applies 
automatically to the section. If you want to change the authority of a new section, for example 
hide it for some groups, choose the dictionary and the section and then specify No accessNo accessNo accessNo access or 
Read accessRead accessRead accessRead access for the groups in question. 
 

Permission SchemesPermission SchemesPermission SchemesPermission Schemes: Set: Set: Set: Setting detailed access permissions for ting detailed access permissions for ting detailed access permissions for ting detailed access permissions for user groupuser groupuser groupuser groupssss    and and and and 
assigning these permissions to assigning these permissions to assigning these permissions to assigning these permissions to dictionaries and sectionsdictionaries and sectionsdictionaries and sectionsdictionaries and sections    
If you need to decide, for all or parts of the database, more than the no access, read access, 
write access and export/import rights provided by Access Editor, click Permission SchemesPermission SchemesPermission SchemesPermission Schemes and 
Enable Permission SchemesEnable Permission SchemesEnable Permission SchemesEnable Permission Schemes.  
Note!Note!Note!Note! 
This will deactivate the settings made in Access Editor, and activate any Permission Schemes 
settings.  
A permission scheme consists of a set of permissions granted for the different user groups. The 
scheme is first edited and saved and then assigned to selected dictionaries and/or sections. 
After having created the user groups (and possibly the users of these user groups), first edit the 
default permission scheme, for all default access rights (normally disabling any automatic 
access for the All users group). Then add a permission scheme for any dictionary or section 
needing specific permissions. The following illustration shows an example of a special 
permission scheme to be applied to a "Suggestions" section. 
Proceed as follows: 
 
1. Click Add Permission SchemeAdd Permission SchemeAdd Permission SchemeAdd Permission Scheme and specify the name and description of the scheme. 
2. For all access permissions on the concept and term level as well as regarding export and 

import, under each permission, add the groups to get the permission.  
Note!Note!Note!Note! If you do not specify any group for a certain permission, only administrators will have 
that permission. 
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3. Click SaveSaveSaveSave. 
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4. Click Edit Scheme AssignmentsEdit Scheme AssignmentsEdit Scheme AssignmentsEdit Scheme Assignments. 
 

 
 

5. Select the dictionary (or section) for which the permission scheme shall be applied in the 
left droplist. 

6. Select the desired permission scheme in the right droplist 
If the permission scheme is to be assigned to more than one dictionary or section, click AddAddAddAdd 
and repeat steps 5-6 for that dictionary or section 

7. Click SaveSaveSaveSave. 
 

Default permission sDefault permission sDefault permission sDefault permission schechechechememememe    

There is always a default permission scheme available. The default scheme can be edited but not 
removed. In the initial setup the default permission scheme is defined to allow all permissions to 
"All Users" group. It is assigned to "All dictionaries", which gives every user full permissions to 
all terminology data. Edit the default permission scheme to limit the base permissions if 
necessary. 

Create and eCreate and eCreate and eCreate and editditditdit permission schemes permission schemes permission schemes permission schemes    

To add a new permission scheme, click Add Permission SchemeAdd Permission SchemeAdd Permission SchemeAdd Permission Scheme on the Permission Schemes list 
page. To edit an existing scheme click EditEditEditEdit for the desired scheme. You can also copy an entire 
scheme by clicking CopyCopyCopyCopy. All these actions will open the Permission Scheme Details page. 

Every scheme requires a unique name for identification. You can also optionally enter a 
description of the scheme. 

You then define which groups should be granted permissions. For each listed permission you can 
add one or more group that should be granted the permission. Click Add GAdd GAdd GAdd Grouprouprouproup to get a droplist 
of the available user groups, and select the desired group. To remove a group from a permission, 
click on the delete icon ( ) to the right of the group. 
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Any user will be granted a specific permission if she is a member of any group with that 
permission granted. 

PermissionPermissionPermissionPermission dependencies dependencies dependencies dependencies    

Some permissions have dependencies on other permissions. For example, a user cannot edit a 
concept which she cannot view, even if the Edit Concept permission is granted. The available 
permissions with dependencies are described in the table below. 

PermissionPermissionPermissionPermission    DescriptionDescriptionDescriptionDescription    Depends onDepends onDepends onDepends on    

View Concept User can view concepts  

Create Concept User can create new concepts 
View Concept, Create Term (for at least one section in the current 
dictionary) 

Edit Concept 
User can edit the current 
concept 

View Concept (and at least one of Edit Concept Level Fields, 
Create Term, Edit Term or Delete Term to be able to make any 
changes) 

Delete Concept 
User can delete the current 
concept 

View Concept 

Edit Concept 
Level Fields 

User can edit fields on the 
concept level in a concept 

Create Concept or Edit Concept 

Create Term 
User can create a new term in 
a concept 

Create Concept or Edit Concept 

Edit Term 
User can edit an existing term 
in a concept 

Edit Concept 

Delete Term 
User can delete an existing 
term in a concept 

Edit Concept 

Import Concepts 
User can import concepts 
from file 

See Importing using Permission Schemes 

Export Concepts 
User can export concepts to 
file 

View Concept 

When importing you may need additional permissions granted depending on your import 
settings. See Importing using Permission Schemes for more information. 

Assign Assign Assign Assign ppppermission ermission ermission ermission sssschemeschemeschemeschemes    

When you have defined your permission scheme you can assign it to dictionaries and sections. 
Click Edit SEdit SEdit SEdit Scheme Assignmentscheme Assignmentscheme Assignmentscheme Assignments on the Permission Schemes list page to open the Scheme 
Assignments page. 

Click AddAddAddAdd to create a new assignment. You will get a row with two droplists; one for dictionaries 
and sections, and one for the permission schemes. Select a combination of dictionary/section 
and scheme to create an assignment. You can delete an existing assignment by clicking the 
delete icon ( ) to the right of the scheme droplist. 

If no scheme is assigned for a specific section in a dictionary, the scheme assigned to "All 
sections" for the dictionary will be applied. If no scheme is assigned for "All sections", then the 
default permission scheme will be applied.  
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Lock Languages: Lock Languages: Lock Languages: Lock Languages:  Disable certain user groups from adding and editing terms Disable certain user groups from adding and editing terms Disable certain user groups from adding and editing terms Disable certain user groups from adding and editing terms 
in certain languagesin certain languagesin certain languagesin certain languages    
1. Select the dictionary where e.g. write access to certain languages should be disabled. 
2. For each relevant user group, click the languages that the members of the user group should 

not be able to add or edit. 
(If you change your mind, Ctrl-click the language.) 

3. Click Apply CApply CApply CApply Changeshangeshangeshanges. 
Please note that the basic access rights to the dictionaries (and their sections) are defined in 
Permission Schemes or Access Editor. 
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Scheduled JobsScheduled JobsScheduled JobsScheduled Jobs: : : :  Regular automated exports of term dataRegular automated exports of term dataRegular automated exports of term dataRegular automated exports of term data    
Here, you can automate the export of terminology data. Proceed as follows: 
Click AdminAdminAdminAdmin > Scheduled JobsScheduled JobsScheduled JobsScheduled Jobs. A list of currently defined jobs will be displayed. 

 
Here, you can select to order a job to be run immediately (Run nowRun nowRun nowRun now), as an example to make a 

test export, refresh the list (click the circular arrow on green background, ), and view the 
results of a certain export (click [more][more][more][more] and the file link that is displayed). You can also delete 
selected exported files with their corresponding log entries and from the job result log. 
To add a job: 
1. Click Add jobAdd jobAdd jobAdd job. 
2. Give the job a descriptive name, select an export setting (if necessary, define an export 

setting under Admin Admin Admin Admin VVVViewiewiewiew > ExportExportExportExport > NewNewNewNew), and enter the path to the server location where 
the export file(s) are to be stored. (Please note that involved software modules need access 
rights to this catalog.)  

3. Also, enter the interval in the ScheduleScheduleScheduleSchedule section. 
4. If you want to keep all runs in the job result log, enter 0 in the Runs to keepRuns to keepRuns to keepRuns to keep field. 
5. If desired, enter the email address where export notifications are to be sent, and the sender 

email and name to be displayed in the notification email. 
6. Click ActiveActiveActiveActive to activate the job immediately. 
7. Click Create jobCreate jobCreate jobCreate job. 
 
For an existing job, click the job name and, in a similar way as described above, you can 
deactivate or activate the job, change parameters and then click Update JobUpdate JobUpdate JobUpdate Job to save your 
changes. 
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Show expression (cron expressions)Show expression (cron expressions)Show expression (cron expressions)Show expression (cron expressions)    

If you want to fine-tune the schedule parameters you can the "cron expression". Then Click 
Show expressionShow expressionShow expressionShow expression. 
A UNIX crontab-like pattern is a string split in five space-separated parts. Each part is intented 
as:  

1. MinuteMinuteMinuteMinutes subs subs subs sub----patternpatternpatternpattern. During which minutes of the hour should the task been launched? 
The values range is from 0 to 59.  

2. Hours subHours subHours subHours sub----patternpatternpatternpattern. During which hours of the day should the task been launched? The 
values range is from 0 to 23. 

3. Days of month subDays of month subDays of month subDays of month sub----patternpatternpatternpattern. During which days of the month should the task been 
launched? The values range is from 0 to 31. 

4. Months subMonths subMonths subMonths sub----patternpatternpatternpattern. During which months of the year should the task been launched? 
The values range is from 1 (January) to 12 (December), otherwise this sub-pattern allows 
the aliases "jan", "feb", "mar", "apr", "may", "jun", "jul", "aug", "sep", "oct", "nov" and 
"dec". 

5. Days of week subDays of week subDays of week subDays of week sub----patternpatternpatternpattern. During which days of the week should the task been 
launched? The values range is from 0 (Sunday) to 6 (Saturday), otherwise this sub-
pattern allows the aliases "sun", "mon", "tue", "wed", "thu", "fri" and "sat". 

The asterisk wildcard character is also admitted, indicating "every minute of the hour", "every 
hour of the day", "every day of the month", "every month of the year" and "every day of the 
week", according to the sub-pattern in which it is used.  

Once the scheduler is started, a task will be launched when the five parts in its scheduling 
pattern will be true at the same time.  
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Some examples:  

5 * * * * 
This pattern causes a task to be launched once every hour, at the begin of the fifth minute 
(00:05, 01:05, 02:05 etc.).  

* * * * * 

This pattern causes a task to be launched every minute.  

* 12 * * Mon 

This pattern causes a task to be launched every minute during the 12th hour of Monday.  

* 12 16 * Mon 

This pattern causes a task to be launched every minute during the 12th hour of Monday, 16th, 
but only if the day is the 16th of the month.  

Every sub-pattern can contain two or more comma separated values.  

59 11 * * 1,2,3,4,5 

This pattern causes a task to be launched at 11:59AM on Monday, Tuesday, Wednesday, 
Thursday and Friday.  

Values intervals are admitted and defined using the minus character.  

59 11 * * 1-5 

This pattern is equivalent to the previous one.  

The slash character can be used to identify periodic values, in the form a/b. A sub-pattern with 
the slash character is satisfied when the value on the left divided by the one on the right gives 
an integer result (a % b == 0).  

*/15 9-17 * * * 
This pattern causes a task to be launched every 15 minutes between the 9th and 17th hour of 
the day (9:00, 9:15, 9:30, 9:45 and so on... note that the last execution will be at 17:45).  

All the fresh described syntax rules can be used together.  

* 12 10-16/2 * * 
This pattern causes a task to be launched every minute during the 12th hour of the day, but 
only if the day is the 10th, the 12th, the 14th or the16th of the month.  

* 12 1-15,17,20-25 * * 

This pattern causes a task to be launched every minute during the 12th hour of the day, but the 
day of the month must be between the 1st and the 15th, the 20th and the 25, or at least it 
must be the 17th.  

Finally cron4j lets you combine more scheduling patterns into one, with the pipe character:  

0 5 * * *|8 10 * * *|22 17 * * * 
This pattern causes a task to be launched every day at 05:00, 10:08 and 17:22.  
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WorkflowsWorkflowsWorkflowsWorkflows        

Workflows Workflows Workflows Workflows iiiintroductionntroductionntroductionntroduction    

With the workflow functionality in TermWeb you can define and automate tasks, control access 
permissions on the field level, and add styling to your term data. 

A workflow is connected to a task in TermWeb, e.g. creating a concept or deleting a term. When 
the task is performed, the associated workflows are executed. For a full list of available tasks, 
see Workflow tasks. 

In a workflow you can define conditions, functions and validations to control what should 
happen when and where. 

ConditionsConditionsConditionsConditions    

Conditions provides more detailed control over when the workflow should be executed. You can 
add conditions for field values in a concept or term, and also check user group membership for 
the user performing the task that triggered the workflow. For instance, you can define a 
workflow only to be executed when the concept has status "Pending" and user is a member of 
the group "Translators". 

For more information about defining conditions, see Editing Workflows. 

FuncFuncFuncFunctionstionstionstions    

A workflow function defines some action that should be performed when the workflow is 
executed. For instance, you can set field values in the concept or term, hide fields or make them 
read-only when editing, or change the field style (color, font style etc). 

You can define the functions to be executed before or after the workflow's task. The functions 
to be executed before the task are defined as prefunctions in the workflow. The functions that 
should be executed when the task finishes are defined as postfunctions. For details about when 
pre- and postfunctions are executed for each task, see Workflow tasks. 

ValidationsValidationsValidationsValidations    

By adding validations to a workflow, you can define that some fields in the concept or term are 
required to have a value before saving, besides the fields already defined to be required in the 
dictionary definition. Using validations you can, for instance, require Definition to have a value 
if Status is set to Approved. 

Validations are only performed when saving after an editing task. For more information about 
validations see Validations under Editing Workflow Details below. 

Create a workflowCreate a workflowCreate a workflowCreate a workflow    

To create a new workflow you must be logged in as an administrator in TermWeb. Go to the 
Admin view and click on the WorkflowsWorkflowsWorkflowsWorkflows icon. 
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This opens the View WorkflowsView WorkflowsView WorkflowsView Workflows screen. Here you see all defined workflows in the system. To 
create a new workflow, click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 

This opens the Add New WorkflowAdd New WorkflowAdd New WorkflowAdd New Workflow screen. 

 

Here you enter a name for the workflow, an optional description, select the task (see Tasks for 
more information), and the dictionary to which the workflow is connected. You can also set 
whether you want the workflow to be active or not. 

Workflow tasksWorkflow tasksWorkflow tasksWorkflow tasks    

The following table lists the available workflow tasks and when pre- and postfunctions are 
executed 

TaskTaskTaskTask    Prefunctions run whenPrefunctions run whenPrefunctions run whenPrefunctions run when    Postfunctions run whenPostfunctions run whenPostfunctions run whenPostfunctions run when    

Create Concept 
User is opening the Edit screen for a 
new concept entry 

The concept is saved 

Edit Concept 
User is opening a concept entry for 
editing 

The concept is saved 

Delete Concept 
User is selecting a concept entry for 
deletion 

After the concept is deleted from the 
database 

Add Term 

User clicks "Add term" when editing a 
concept entry 
orororor 
User clicks "Edit term" on a term 
entry that not has been saved to 
database 

User clicks "Save" in the term entry 
fields panel 

Create Term 

A new concept entry is saved (for 
each term entry) 
orororor 
A concept entry is saved after editing 
(for each new term entry) 

Directly after prefunctions 

Edit Term 
User clicks "Edit term" on a term 
entry already stored in database 

User clicks "Save" in the term entry 
fields panel 
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when editing a concept entry 

Update Term 
A concept entry is saved after editing 
(for each modified term entry) 

Directly after prefunctions 

Delete Term 

A concept entry is saved after editing 
(for each deleted term entry) 
orororor 
A concept entry is deleted (for each 
term entry) 

Directly after prefunctions 

View Term in List A term is displayed in the term list Directly after prefunctions 

View Concept 
A concept entry is displayed in the 
result window 

Directly after prefunctions 

View Term 
A term entry is displayed (collapsed 
or expanded) in the result window 

Directly after prefunctions 

Select Term when 
Editing 

A term entry is selected in the Edit 
concept window 

Directly after prefunctions 

Editing Editing Editing Editing wwwworkflow orkflow orkflow orkflow ddddetailsetailsetailsetails    

To specify what actions should be performed by a workflow you click "Edit Details" in the 
workflow list page. The "Edit Workflow Details" view opens. 

ConditionsConditionsConditionsConditions    

The conditions in a workflow determines when the workflow is executed. You can define a 
logical statement based on values in fields or the user's group. Click on "Edit Conditions" to 
open the conditions editor. 

Only picklist fields can currently be used in workflow conditions. The selected field values should 
match the values in the entry being displayed or edited for the workflow to run. 

If the workflow task affects a concept, e.g. Edit Concept or View Concept, and you have defined 
term level fields in the workflow conditions, all terms in the concept must fulfill the term level 
conditions. If the task affects a term, e.g. Edit Term or View Term in List, only the selected term 
and its concept must fulfill the conditions. 

FunctionsFunctionsFunctionsFunctions    

Workflow functions are actions that the workflow performs when executed. They are divided 
into Prefunctions and Postfunctions, where the prefunctions are executed at the beginning of 
the workflow's task, and the postfunctions are executed at the end. See Tasks for a full 
description. 

Function typesFunction typesFunction typesFunction types    

The following workflow function types are available: 

• Set Field Value 
Sets the value for a field in the current entry. 

• Render Field 
Changes how a field in the current entry is rendered, e.g. hidden or read-only. 
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• Style Field 
Changes the appearance of a field in the current entry, e.g. color or size. 

• Send Email 
Sends a customizable email to a single user or group of users. Emails can be sent directly 
or collected in a digest sent on a regular interval. 

• Set Permission Scheme 
Temporarily changes the permission scheme for the user for the duration of the task. 

ValidationsValidationsValidationsValidations    

Validations allow you to specify fields that should be required during an editing operation, 
besides the fields already defined as required in the dictionary definition. The workflow 
validations are checked when the entry is saved, and if a required value is missing the user will 
be informed and not able to save until a value is entered in the required field. 

Usage examples of TermWeb 3.8 workflow functionsUsage examples of TermWeb 3.8 workflow functionsUsage examples of TermWeb 3.8 workflow functionsUsage examples of TermWeb 3.8 workflow functions    

A) Force term creators to fill in another field if a certain value is chosen for a certain fieldA) Force term creators to fill in another field if a certain value is chosen for a certain fieldA) Force term creators to fill in another field if a certain value is chosen for a certain fieldA) Force term creators to fill in another field if a certain value is chosen for a certain field    

In this example, to check that the definition is filled in when the concept status is changed to 
Approved. 

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows.  
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, add a description, select "Edit concept" in the TaskTaskTaskTask list and 

specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
4. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
5. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated ("Status is Approved" in the 
example). 

6. To the right of Defined validationsDefined validationsDefined validationsDefined validations, click Edit ValidationsEdit ValidationsEdit ValidationsEdit Validations, and, on the DefinitionDefinitionDefinitionDefinition field 
line, click the Not required Not required Not required Not required value to toggle it to Required Required Required Required and click SaveSaveSaveSave. 

7. Click SaveSaveSaveSave again. 
8. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive to toggle it to Active.Active.Active.Active. 

Now, when the status of a concept is changed to Approved, the user will get a signal that the 
definition is missing when trying to save the concept:  
"Field required by workflow. Please enter Definition." 

B) Mark unapproved terms in term list with another color (red)B) Mark unapproved terms in term list with another color (red)B) Mark unapproved terms in term list with another color (red)B) Mark unapproved terms in term list with another color (red)    

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows.  
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, add a description, select "View term in list" in the TaskTaskTaskTask list 

and specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
4. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
5. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated and click SaveSaveSaveSave. 
6. To the right of Defined postfunctionsDefined postfunctionsDefined postfunctionsDefined postfunctions, click Add FunctionAdd FunctionAdd FunctionAdd Function, select Style FieldStyle FieldStyle FieldStyle Field and click 

AddAddAddAdd. 
7. Select TermTermTermTerm in the FieldFieldFieldField droplist, red color in the ColorColorColorColor field and font size, style and 

decoration as desired. 
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8. Click Save.Save.Save.Save.    

 
9. Click Save.Save.Save.Save. 
10. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive to toggle it to Active.Active.Active.Active. 

    
Note!Note!Note!Note! 
If you also want the occurrence of a deprecated term to be signaled in red in the result window, 
create a similar workflow for the task "View term"! 
    

C) Signal the addition of a term (or terms) by email from the systemC) Signal the addition of a term (or terms) by email from the systemC) Signal the addition of a term (or terms) by email from the systemC) Signal the addition of a term (or terms) by email from the system 

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows. 
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, add a description, select "Create term" in the TaskTaskTaskTask list and 

specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
4. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
5. To the right of Defined conditionDefined conditionDefined conditionDefined conditionssss, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated ("Sections is Suggestions" in the 
example) and click SaveSaveSaveSave. 

6. To the right of Defined postfunctionsDefined postfunctionsDefined postfunctionsDefined postfunctions, click Add FunctionAdd FunctionAdd FunctionAdd Function, select Send EmailSend EmailSend EmailSend Email, and click 
AddAddAddAdd. 
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7. Enter info as desired (send notification to group or to one user) and whether to collect 
info about more than one event in an email, e.g. daily (Send emails as digestsSend emails as digestsSend emails as digestsSend emails as digests). 

 
8. Click SaveSaveSaveSave. 

 
9. Click SaveSaveSaveSave again. 
10. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive to toggle it to Active.Active.Active.Active. 

    
As an example, here a terminologist could get a list of term suggestions entered by other people 
in the organization on a regular basis. In that case, a condition that the term suggestion is 
entered in an "open" suggestion section could be added to the workflow. This way, the addition 
of new terms by terminologists in other, published, sections will not be signaled to the selected 
user or user group: 
 
Resulting email (including permalinks) when terms created in Suggestions section: 
Administrator created a term entry: skalbagge (swe) 

Entry URL: http://demo38.termweb.se:80/demo38/view/23lq9/23lqa 

Administrator created a term entry: beetle (eng) 

Entry URL: http://demo38.termweb.se:80/demo38/view/23lq9/23lqb 

Administrator created a term entry: beatle (eng) 

Entry URL: http://demo38.termweb.se:80/demo38/view/23lq9/23lqh 

___ 
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New term added 

-- 

This message is automatically generated by TermWeb. 

-- 

 
DDDD)))) Automatically set concept status to Approved if all terms have Process status Finalized Automatically set concept status to Approved if all terms have Process status Finalized Automatically set concept status to Approved if all terms have Process status Finalized Automatically set concept status to Approved if all terms have Process status Finalized    
Simply create a workflow like this: 

1. Click AdminAdminAdminAdmin (Admin view) > WorkflowsWorkflowsWorkflowsWorkflows. 
2. Click Add WorkflowAdd WorkflowAdd WorkflowAdd Workflow. 
3. Name the workflow function, add a description, select "Edit concept" in the TaskTaskTaskTask list and 

specify for which dictionary the workflow function should apply. Then click SaveSaveSaveSave. 
4. Click Edit DetailsEdit DetailsEdit DetailsEdit Details for the workflow function. 
5. To the right of Defined conditionsDefined conditionsDefined conditionsDefined conditions, click Edit Conditions Edit Conditions Edit Conditions Edit Conditions and specify under what 

condition the workflow function should be activated. 

 
6. Click SaveSaveSaveSave. 
7. To the right of Defined postfunctionsDefined postfunctionsDefined postfunctionsDefined postfunctions, click Add FunctionAdd FunctionAdd FunctionAdd Function, select Set Field Value Set Field Value Set Field Value Set Field Value and click 

AddAddAddAdd. 
8. Select StatusStatusStatusStatus in the FieldFieldFieldField droplist, and "Approved" in the Set value to Set value to Set value to Set value to field and click 

SaveSaveSaveSave. 

 
9. Click SaveSaveSaveSave again. 
10. Activate the workflow function by clicking the text Inactive Inactive Inactive Inactive (in the Status column) to 

toggle it to Active.Active.Active.Active. 
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Change PasChange PasChange PasChange Password: Change your passwordsword: Change your passwordsword: Change your passwordsword: Change your password    
Change your password. If you as an administrator want to change passwords for other users, 
click Admin viewAdmin viewAdmin viewAdmin view and choose UsersUsersUsersUsers. 

1. Click Change PasswordChange PasswordChange PasswordChange Password. 
2. Enter the old password once and the new password twice. 
3. Click SaveSaveSaveSave. 
4. Click Search ViewSearch ViewSearch ViewSearch View if you want to return to searching for terms (or Log outLog outLog outLog out). 

 

Administrator Tools: Reindex a dictionaryAdministrator Tools: Reindex a dictionaryAdministrator Tools: Reindex a dictionaryAdministrator Tools: Reindex a dictionary    

 
Sometimes it can be helpful to reindex a dictionary in order to increase the speed of a search. To 
reindex: 

1. Click Administrator ToolsAdministrator ToolsAdministrator ToolsAdministrator Tools. 
2. Select the dictionary you wish to reindex from the DictionaryDictionaryDictionaryDictionary field. 
3. Click Start ReindexingStart ReindexingStart ReindexingStart Reindexing. 
4. Click OKOKOKOK when a message that the reindexing has been completed appears in the 

window. 
 

Usage StatisticsUsage StatisticsUsage StatisticsUsage Statistics    
To display usage statistics over user visits, time spent, and user origin per day, month or year for 
your TermWeb installation, proceed as follows:  

1. Click StatisticsStatisticsStatisticsStatistics. 
2. For usage details regarding a certain day, click Details Details Details Details on the corresponding line. 

 
To show statistics for another month, click the name of month previous or following the 
currently displayed month. 
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Terms used in this documentTerms used in this documentTerms used in this documentTerms used in this document    
Term recordTerm recordTerm recordTerm record: A term record is the part of a structured terminological data omnibus that is 
applicable to a specific concept. (This concept is expressed normally by different term 
equivalents in various languages.)    
Term equivalentTerm equivalentTerm equivalentTerm equivalent: Term equivalent is used to refer to a word or expression that represents the 
same or a similar concept in different languages.  
 


